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What is Ecce? 

The Extensible Computational Chemistry Environment (Ecce) is an extensible computing 
environment for molecular modeling, analysis, and simulation. It is the first 
comprehensive, integrated problem-solving environment developed for computational 
chemistry. Ecce simplifies the work of doing computational chemistry calculations by 
providing tools and a unified interface for chemists to interact with 

• computational chemistry codes and methods  
• a well-designed chemistry data model and data server  
• distributed network computing resources, including high-performance parallel 

computing systems  
• useful views and visualizations of computational results and other data server data  
• 3D building and visualization of chemical systems, including large molecular 

residues imported from Protein Data Bank files for molecular dynamics (MD) 
calculations or chemical systems created in the Ecce Builder tool and converted to 
residues by the Builder's MD Toolkit.  

Ecce's extensible structure is designed to accommodate new codes, tools, data, and 
machine resources. 

See also... 

• Ecce Tools  
• Key Concepts to Know About Ecce  
• Ecce Home Page  
• Molecular Science Software Suite  
• How to Acknowledge and Cite Ecce 

Computational Chemistry Codes and Methods 

To have the flexibility for handling a wide variety of chemical systems, most 
computational chemistry codes support a large number of input parameters. Ecce's 
unified interface means that chemists can learn a single set of tools to work with multiple 
computational codes and perform many common types of calculations without needing to 
recall the input syntax for those codes. Structures created for use with one code can be 
reused in a different calculation using another code. 

Ecce currently supports the NWChem 4.0 , Gaussian 03 , Gaussian 98 , and 
Amica computational codes.  

Data in Ecce 

All Ecce users have access to reference basis sets, molecular structures, and periodic 
table information. You can create your own collections of calculations and molecular 
structures. Collections of calculations are visualized and manipulated in a Calculation 
Manager tool with calculation results reported and viewable in a Calculation Viewer tool. 
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Ecce is built around an object-oriented data model and a data server implemented on a 
WebDAV-enabled Web server (WebDAV = Distributed Authoring and Versioning). The 
data model is designed to accommodate both experimental and computational results. 
The data server is designed to contain meaningful chemistry objects that can be stored, 
queried, and readily manipulated for use in computational codes and other chemistry 
tools in Ecce. The Ecce interface allows chemists to make smooth use of the data server 
data in building computational chemistry calculations and in storing, visualizing, and 
analyzing the results. 

The data objects make the software highly extensible to software applications. 
Applications built to handle the standard set of data objects can be used as Ecce tools.  

Networked Computing Resources 

Ecce manages the submission and execution of computational code calculations on 
networked high-performance computers. Ecce's Job Launcher tool permits transparent 
password access to these distributed computing resources, managing and hiding the 
complexity of using multiple machines over the network. 

Views and Visualizations 

Views and Visualizations in Ecce Ecce Tool 
Visual hierarchy of projects and calculations stored on Web server Calculation Manager
Graphic 3D visualizations of chemical systems or structures under 
construction 
Graphic 3D visualizations of MD trajectory calculations from 
NWChem 

Builder 

Graphic 3D visualizations of prebuilt molecular structures Structure Library 
List and tables of inputs and outputs from a single calculation 

Graphic 3D visualizations of the chemical system and calculated 
properties (such as isosurfaces for molecular orbitals and electron 
density, animations of normal modes and geometry trace results) 

Calculation Viewer 
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Get Started - The Ecce Gateway 

If you are unfamiliar with using Ecce software and want to know how to begin, then you 
are in the right place.  

On the other hand, if you are looking for... ...then try these topics: 
how to use Ecce tools to set up and run a 
calculation 

Setting Up and Running a 
Calculation 

basic conventions for interacting with Ecce Conventions for Using Ecce 
how to register to be an Ecce user Ecce registration  
what Ecce is and what it does for you What is Ecce? 

Starting and Quitting the Gateway 

To start Ecce: 

1. Type the command ecce (all lowercase) at the UNIX or LINUX terminal prompt. 
Ecce will prompt you for a password: 
 

 
 
First-time Ecce users:  

a. A message will display asking you to create an Ecce password.  
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b. Click OK. The Ecce Password window will display. 

 
c. Type a password that you will use to log in to Ecce. This can be any string 

of alphanumeric characters, including spaces, but must be at least 4 
characters long.  

d. Click the OK button. A confirm new password dialog will display.  
e. Click the OK button. Depending upon whether Ecce support for automatic 

data server account creation is enabled at your site, another dialog may 
request password authentication for the Ecce Web server (example shown 
here). 
 

 
f. Enter your user name and Ecce data server password (obtained from the 

administrator of the Ecce Web database server at your location) and click 
the OK button. 
This authentication to the server is a one-time task. 

Note: You may see similar requests for password authentication when you 
use other Ecce tools to access data other than your own or data on a 
different Web server. If you need to check your data server password, 
click the Lookup button after first typing in your ecce password. The 
Lookup Data Server Password window will display your data server 
password. This is especially useful if you need to run on two hosts that 
don't share a common shared file system home directory.  

g.  
2. Enter your Ecce password and click the OK button.  

 
This opens the Ecce Gateway: 
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The Gateway is a toolbar that gives you central access to key Ecce tools for creating, 
managing, and examining computational chemistry calculations. The Gateway is the first 
tool that you will interact with when you start Ecce. 

Note: Most mouse point-and-click interactions in Ecce use the left mouse button .  Use 
the left mouse button unless specified otherwise. 

To quit an Ecce session (and close all Ecce tool windows): 

1. Open the general window control menu: using the mouse, click on the menu 
button in the upper left corner of the Gateway. If you are using a window 
manager which does not display a menu button, click anywhere on the Ecce wave 
icon or on the exit label below it.  

2. From the resulting menu choose Close (or Quit) or press Alt+F4.  

Ecce asks for confirmation: 

 

3. Choose Yes to end the Ecce session.  

Tip: To close an individual Ecce tool window double-click on the menu button 
in the upper left corner of the tool window (or single-click and choose Close from 
the resulting menu).  

4. If you have unsaved work that is in progress and critical to the definition of a 
calculation, Ecce will ask whether you want to save your work before quitting. 
The Job Launcher will not exit when you quit Ecce from the Gateway while a job 
is currently being launched. It will immediately exit when it is safe to do so after 
the job launch is done and monitoring has been started.  



Ecce Version 3.2.2 Users Manual 

 6

Using Tools from the Ecce Gateway 

Start an Ecce tool by clicking on the corresponding tool icon in the Gateway. An 
appropriate tool to begin with is the Calculation Manager--Ecce's "master" tool. From the 
Calculation Manager you can create calculations and call on other tools to plan, launch, 
and monitor a large number of calculations, as well as examine and manipulate the results. 

Tip: To start more than one instance of a tool, shift-click on the Gateway tool icon when 
the tool is already open. 
OR 
Click on the tool icon with the right mouse button . From the resulting pop-up menu, 
choose New.  
Tip: To bring the Gateway to the front when it is hidden by other windows, first right-
click on the message area in the footer of most Ecce tool windows. From the resulting 
pop-up menu, choose Show Gateway. 
Tip: The Ecce wave animates whenever you start a tool from the Gateway. To stop the 
animation, click on the wave icon. The animation will stop without causing you to exit 
Ecce. This feature also enables you to stop a runaway animation if the tool fails to come 
up for any reason. 
How to... Access Ecce Tools 
  Manage Ecce Tools on the Desktop
More about... Items in the Ecce Window Footer 

Summary of Gateway Tools 

The online help overview of each tool is accessible from the Help Contents page--or just 
click on the corresponding tool icon in the following table. Some Ecce tools are not 
available directly from the Gateway but rather are available within the tools started from 
the Gateway. For similar descriptions of all Ecce tools, see the Ecce Tool Matrix.  

Tool What You Can Do with the Tool 
 

 

Create, organize, and manipulate calculations stored by Ecce. Select 
calculations for use in other Ecce tools, such as the Calculation Editor or Job 
Launcher. 

 

 

Build chemical systems to be used in calculations. Visualize, build, modify, 
and manipulate small molecules in 3D or stereo views. Retrieve and view 
prebuilt structures from the Ecce Structure Library. 

 

 

Select predefined Gaussian basis sets or create new ones for use in ab initio 
electronic structure calculations within Ecce. Access general information on 
the basis sets stored in the EMSL Gaussian Basis Set Library. 



Ecce Version 3.2.2 Users Manual 

 7

 

 

View an image of your calculation and information about your calculation 
such as code type, theory/runtype, basis set, setup parameters, and launch 
information.  

 

 

View status and reference information about computers that are registered as 
Ecce machines. Match computing resources with the job resource 
requirements of new calculations. Set up machine defaults for running 
calculations on a specific computer. 

 

 

View element reference information, including atomic mass, isotopic 
abundance, nuclear spins, electronic configuration, and atomic energies. 

 
 Display the Contents page for Ecce online help in the Netscape web browser. 
 
 Send a support request to the Ecce development team about problems, 
suggestions, questions, and opinions. 

 
 Set your preferences for units, colors for calculation states, audible beeps, and 
other items in the Ecce interface. 

 
 Access currently active Ecce tools through a pull-down menu located on the 
right side of the Gateway. The pull-down menu lists the open tool windows. 

Where to Get Help 

Online help about a specific Ecce tool 
Overview of the tool  From the tool's Help menu, choose Help on [that tool]. 
Quick Help about items in 
an Ecce window  

1. Position the mouse cursor over the item. 
2. Press the Help key (F1 on SGI and PC keyboards). 
If no Quick Help is available for that item, Ecce opens the 
online help overview of that tool in the Netscape web 
browser.  

Technical Support 
How to obtain Ecce 
software  

Refer to the Ecce web site . 

Problems, suggestions, 
questions, requests, and 
opinions addressed to the 
Ecce development team 

EMSL Collaborators: 
Please address your email queries or comments to ecce-
support@emsl.pnl.gov, or use the Support option on the 
Help menu of any Ecce tool window.  
 
Other users of Ecce at other sites: 
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Please contact your onsite representative first to see if your 
need or problem can be resolved. If your site administrator 
has configured Ecce's tool support option, the Help menu of 
each tool window contains a Support option for sending 
email to your onsite representative. 

Ecce procedures, training, 
selection of computing 
platforms, computational 
chemistry and computer 
science consulting 

EMSL Collaborators: 
Use the web-based MSCF Consulting support request form 
to request support. 
OR 
Address email to mscf-consulting@emsl.pnl.gov  

Other users of Ecce at other sites: 
Please contact your onsite representative first to see if your 
need or problem can be resolved. 
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Overview - Learn to Use Ecce 

Start here to learn key concepts, terms, conventions, and options for using Ecce. 

See also... How to Acknowledge and Cite Ecce 

Key Concepts to Know About Ecce 

An Ecce calculation refers to 

• inputs and outputs of a single run of a computational chemistry code  
• setup information for using a specific Ecce-registered machine for processing  
• a name and visual representation in the Ecce Calculation Manager  
• an Ecce database object, which contains setup information and data properties 

from the computational run.  

To run Ecce calculations, you must have UNIX accounts set up for 1) at least one 
machine where you can run the Ecce software, and 2) at least one Ecce-registered 
machine where the calculations can be processed and the appropriate computational 
codes are available. These may be the same machine. If you have accounts on several 
Ecce-registered machines, then you have more options about where to run calculations. 

After your account(s) are properly set up, you can prepare and launch a calculation 
from your desktop workstation. Launch means to submit a calculation for processing 
on an Ecce-registered machine. Your desktop machine either runs the Ecce software or is 
logged in to a machine that can. The machine that runs the Ecce software is the launch 
machine. The machine that runs the computational codes is the run machine, sometimes 
referred to as the remote machine (even if it isn't really remote). 

The inputs and results of calculations are stored on an Ecce Web server. This 
"database" of calculations is organized as a hierarchy of projects and calculations, 
roughly comparable to the folders and files of a personal computer. A project is a 
container that may include calculations and other projects. In this context, each 
calculation is an object that includes code input files, machine configurations, output files, 
and Ecce run logs. The Ecce Calculation Manager visually represents the calculation 
database as a collection of project folders that contain calculations. 

Most Ecce users store their calculations in the "users" folder of the Web server, 
although it is possible to store calculations (and other Ecce objects such as chemical 
system structures) in any folder where you have read/write access. 

Pathname structures / users / username / project / calculation 
/ users / username / project / subproject / calculation 

Example pathnames /users/raypalmer/HardWater/IceNine 
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/users/d35841/Aromatics1/benzene/benzeneMO1 

A calculation also produces temporary files on the run machine--the Ecce-registered 
machine that processes a calculation. These include output files in a calculation directory 
and working files in a scratch directory. After successful completion of a calculation, the 
output files are copied from the calculation directory on the run machine to the project 
folder on the Ecce Web server, where they are stored as part of the calculation object. 

Note: These run machine files are NOT automatically deleted: they can be useful for 
diagnosing run problems and for backup in case of network failures. You can (and 
should) clean up these run directories periodically to conserve disk space. See the 
Calculation Manager's option for Run Mgmt: Cleanup Run Directory Files. 

Calculation property data displays are dynamic. Most displays of Ecce data are 
updated to reflect the changing conditions (as a running calculation completes each 
processing step, for example). 

Conventions for Using Ecce 

It will be helpful to understand the following conventions as you interact with Ecce tools 
and processes.  

- Tool Windows 

You can start the major Ecce tools either from the Gateway or from the Tools menu of an 
Ecce tool window. Although many tools operate in the context of a single calculation, 
you can open multiple instances of a tool window to work on more than one calculation 
at a time by shift-clicking on a tool icon in the Gateway or on a menu item in a Tools 
menu..  

How to... Manage Tools on the Desktop

 

Most major tool windows include a menu bar for choosing task options and a window 
footer.  

Menu Bar  
Each of the menus on the menu bar can be "torn off" as an independent window 
that remains visible while you work. To "tear-off" a menu, open the menu by 
clicking on the menu title and then choose the dashed line that separates the menu 
title from the menu options.  
Tip: Open any menu from the keyboard by using the Alt+underlined letter 
combination (for example, Alt+h opens the Help menu). Then select a menu 
option by pressing the letter that corresponds to the option. 
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Window Footer  
A footer area at the bottom of most tool windows displays status information. The 
footer usually includes a message area for system messages and instructions.  
More about... Items in the Ecce Window Footer

- Labeling Conventions 

The labels on buttons and in menus convey the following information by their appearance.  

Label 
Examples 

Convention 

   
Dark labels - indicate that the option is available. 

   
Grayed-out labels - indicate the option is not available in the current 
context. The option will become available under other conditions. 

 Ellipsis marks (. . .) - indicate that the option will open a separate 
window or dialog for further interactions. 
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- Visual Indicators (What's Happening?) 

The mouse cursor and various elements of Ecce tool windows provide visual feedback 
about current operations and conditions.  

Mouse Cursors The mouse cursor will change color and shape to indicate the status of 
various operations. For example: 

 
Yellow cursor - indicates Ecce is processing a request (such as opening 
a tool after you click on an icon in the Gateway). 

 
Stopwatch cursor - indicates Ecce is processing a tool request (such as 
loading calculation properties into the Calculation Viewer after a drag-
and-drop from the Calculation Manager). 

  

  

  

Drag & Drop cursor - indicates that an information object is being 
dragged. The cursor turns green when it points to a drop site where the 
object can be dropped. The cursor turns red when it points to a drop site 
where the information is inappropriate and cannot be dropped. The 
actual appearance of the drag & drop cursor varies, depending on the 
graphic interface of your system. 

 
Hand cursors - indicate various types of chemical system manipulation 
operations in the Builder tool. 

Icons Special icons in the Gateway or in tool windows indicate the status of 
programs or data. 

 

Ecce wave animation (System Busy icon in the Gateway) - indicates 
that an Ecce tool is opening.  
Tip: If you click on the Ecce wave while it is moving, the animation 
will stop for that instance. You can permanently disable this system 
busy icon by changing Preferences.  

 
 
 

 

Calculation state icons - indicate (by their shape and color) the 
preparation or processing state of Ecce calculations. For more details, 
see Legend of Calculation Run States in the Calculation Manager. 

 "Save Work" star icon - indicates that your work in an Ecce tool has 
not been saved to a database. (Click on the star icon to save your work 
and remove the Save Work icon.) 

 Padlock icon - indicates that you cannot change inputs in the current 
window at the current time, such as the inputs of a running calculation. 
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- Mouse Conventions 

 Left click - Most mouse interactions in Ecce use the left mouse button. When 
following online help instructions, use the left mouse button unless specified 
otherwise. 

Shift +  
Ctrl +  

Shift-click and Ctrl-click - Combinations of the left mouse button with the 
Shift or the Ctrl key are used for various special purposes in data tables, in the 
Builder work area, and the Calculation Manager. These uses are specified in 
the online help pages for the corresponding tools. 

 Middle-click-and-hold - The middle mouse button is used generally for Ecce 
drag & drop operations (as well as special operations in the Builder). 

 Right-click - The right mouse button is most often used to open a pop-up 
menu of options that apply to the clicked area. 

 Point-and-Help - The Help key (typically the F1 key) is used with the mouse 
pointer (no button click!) to provide access to Quick Help - short 
descriptions of items within a tool window.  

- Drag & Drop 

Ecce's drag & drop operations enable you to use the mouse to move several kinds of 
information within and between Ecce tools. By use of the middle mouse button, certain 
information objects can be quickly dragged from one location and dropped at another. 
Examples:  

  

Reorganize items within a tool 
 Change the position of a calculation property column in Calculation Manager (in the 
Edit / Preferences window). 

 Move or copy (Ctrl + ) your folders in the project tree of the Calculation Manager.
 Change the position of a property in the summary list of the Calculation Viewer.  

Move information between tools 
 Drag a calculation from the Calculation Manager  
- to the Calculation Editor (for editing input parameters for that calculation) 
- to the Basis Set Tool (for choosing basis sets for that calculation)  
- to the Calculation Viewer (for visualizing the calculation's chemical system)  

 Drag a chemical system from the Builder to another tool such as the Calculation 
Editor.  

The information actually transferred between tools depends on what information is usable 
in the destination tool. For example, a calculation object dragged from the Calculation 
Manager can load the Builder with the calculation's chemical system or load the 
Calculation Editor with the calculation's current input parameters. 
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How to...  Drag & Drop with the Mouse  
   Move a Project or Calculation in the Calculation Manager

Drop Sites. Information can be dragged only to a drop site - a destination for "drag & 
drop" operations.  

Warning: Dropping on a drop site that is not ready (usually because it is still processing 
the last drop) may cause crashes. See how to Drag & Drop with the Mouse (above). 

Drop Sites Description 

 

The square "in-tray" area in the lower right corner of many Ecce 
windows is the main type of drop site for receiving information from 
other tools. 

 In the Calculation Manager's project tree, you can move or copy (Ctrl + 
) one of your project folders by dragging and dropping it onto another 

of your project folders. 
Summary 
Caption 

In the Calculation Viewer, summary item captions can be rearranged by 
dragging and dropping them onto each other. 
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Exporting and Importing Ecce Data 

Exportable Data Export Format(s) Tools and Options 
Builder / File menu / Export molecular structure 

and graphic formats Structure Library / Structure menu / Export 
Chemical system 

graphic formats Calculation Viewer / Calculation menu / 
Export 

Values for a 
calculated property 
(table) 

spreadsheet-readable 
formats 

Calculation Viewer / data panel / pop-up 
menu / Export 

Basis sets selected 
for a chemical system 

ASCII file Basis Set Tool / Molecular Basis menu / 
Save to File 

A general printing option in several tools enables printing either to a postscript file or to a 
postscript printer selected from a list of available printers.  

Printable Data Tools and Options 
Builder / File menu / Print Chemical system image 
Calculation Viewer / Calculation menu / Print 

Values for a calculated 
property (tables and graphs) 

Calculation Viewer / data panel / pop-up menu / Print 

Importing options include molecular structures and completed calculations.  

Importable Data Import Format(s) Tools and Options 
Builder / File menu / Import 
Structure Library / Structure menu / 
Import 

Chemical system molecular structure 
formats 

Basis Set Tool / Browse Options menu 
/ Import Fragment 

Calculation (code 
outputs) 

NWChem output file 
(ecce.out) 
Gaussian94 output file 
(filename.out) 
Gaussian98 output file 
(filename.out) 

Calculation Manager / Calculation 
menu / Import 
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Customizing Ecce 

Ecce includes several preferences that you can set to control the behavior and appearance 
of Ecce tools. Preferences include the date format, the colors associated with calculation 
run states, and some units (energy, distance, frequency). 

Moving Between Ecce Versions 

If you need to run both Ecce v2.1 and v3.0 or higher back to back, Ecce offers a simple 
mechanism to support switching preference files between versions. When you first start 
v3.0, Ecce recognizes the presence of any v2.1 preference files and converts them to v3.0 
format. The v2.1 files are copied to files of the same names with extensions of .v2.1. By 
copying the .v2.1 files back over top of the v3.0 counterparts, the older version of Ecce 
can be run again and Ecce will re-convert the files to v3.0 format when that version is run. 
A new script named reformat_machines is automatically called by Ecce to do this 
conversion for you. 

How to... Set Preferences 
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Overview of Ecce Tools 

 

The Ecce Gateway (above) gives you central access to key tools that can operate 
independently (outside the context of a specific calculation). Other tools are generally 
accessed by means of a "Tools" menu within each key tool. 

The following table summarizes the major Ecce tools and the access they provide to each 
other. The table orders the tools in a general sequence that you might follow to set up a 
calculation, run it, monitor its progress, and view the results. 

See also... Starting and Quitting the Gateway 
  Setting Up and Running a Calculation

Tool Matrix Table 

In the following matrix table of Ecce tools, you can click on:  

tool 
names 

As on the Help Contents page, the tool name will take you to the help page for 
that tool. 

tool 
buttons 

As on a tool help page, the tool button will display an annotated picture of the 
tool. The main help page for any tool is available from the Help menu on the 
tool's menu bar. 

 

Button What You Can Do with the Tool Access to Other 
Tools 

 

 

Calculation Manager -- Create, organize, and manipulate 
a large number of calculations in Ecce databases. Select 
calculations for use in other Ecce tools. 

Builder  
Calculation Editor 
Basis Set Tool 
Job Launcher 
Calculation Viewer

 

 

Builder -- Build chemical systems to be used in 
calculations. Visualize, build, modify, and manipulate 
small molecules in 3D or stereo views. Access the Ecce 
Structure Library. 

Structure Library 

 
Structure Library -- Retrieve and preview prebuilt -- 
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structures from an extensive collection of molecules 
contained within the shared "Structure Library" folder. 
Select structures for use in the Builder. 

 

 

Calculation Editor -- Specify most user-adjustable input 
parameters to a calculation without needing to recall the 
syntax or options of the code. Edit the input file directly 
(if desired). Select from the NWChem, Gaussian-03, 
Gaussian-98, and Amica editors. 

Builder  
Basis Set Tool 
Job Launcher  

 

 

Basis Set Tool -- Select predefined Gaussian basis sets or 
create new ones for use in ab initio electronic structure 
calculations. Access general information on the basis sets 
stored in the EMSL Gaussian Basis Set Library. 

-- 

 

 

Machine Browser -- View status and reference 
information about computers that are registered as Ecce 
machines. Match computing resources with the job 
resource requirements of new calculations. Set up 
machine defaults for running calculations on a specific 
computer. 

-- 

 

 

Job Launcher -- Modify or specify launch parameters 
for calculations on Ecce registered machines. Launch a 
job (submit a calculation to a computer for processing). 

-- 

 

 

Calculation Viewer -- View information about a single 
calculation stored in an Ecce database. Tabulate, graph, or 
visualize the chemical system and its computed 
properties. 

Viewing Tools:  
Geometry Trace 
Molecular Orbital 
Normal Mode 

 

 

Periodic Table -- View element reference information, 
including atomic mass, isotopic abundance, nuclear spins, 
electronic configuration, and atomic energies. 

-- 

 
 Preferences -- Set your own choice of calculation state 
colors, audible "beep" notification, and other items in the 
Ecce interface. 

-- 

 
 
Support -- Open a Support form for sending questions to 
your onsite Ecce representative or administrator (if Ecce 
has been configured with that person's e-mail address). 

-- 

 
 Help -- Display the Help Contents page for Ecce online --  
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help. 
Button What You Can Do with the Tool Access to Other 

Tools 
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Overview - Calculation Manager 

This tool allows you to organize and manipulate calculations in Ecce. By invoking other 
tools from the Calculation Manager, you can plan, submit, and monitor a large number of 
calculations, as well as examine and manipulate the results. 

The Calculation Manager window depicts calculations within projects, much as the 
Microsoft Windows Explorer depicts files within folders on a personal computer. A 
project is a container that may include calculations and other projects. A calculation 
represents a single computational run (including restarts).  

The Calculation Manager window is split into three panes. The left pane displays the 
project tree. The right pane or project workspace lists the contents of the current project 
(the project selected in the project tree). The bottom pane or message area displays 
information about current operations. 

Selecting a calculation in the Calculation Manager provides a means to manipulate the 
parameters and results of that calculation. When the Calculation Manager is opened and 
displays the last-used project area, the project tree automatically scrolls the project into 
view in the tree.  

Names of projects displayed above the message area show the name of the data server in 
URL format rather than just the path to the calculation.  

Key Concepts: 

• Current Selection - The Calculation Manager generally operates on the project 
or calculation that is selected and highlighted in the right pane. To select a 
calculation or project, click once on that item in the right pane.  

• Where you can store calculations - The project tree corresponds to a UNIX 
directory tree on the Ecce production Web server. In principle you can store Ecce 
projects and calculations anywhere on this server where you have read/write 
access. In practice you may be restricted to a single user directory corresponding 
to your user name (and prompted for password authorization of activities 
outside your user directory).  

Starting the Calculation Manager 

 

Click on the Calculation Manager icon in the Ecce Gateway. If the Calculation Manager 
is already running, this will bring its window to the front. To start a separate instance of 
the Calculation Manager in a separate window, shift-click on the icon. 
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The following items briefly describe elements of the Calculation Manager window. 

Toolbar 

The Calculation Manager's optional toolbar provides one-click editing and movement 
around the project tree. To show/hide the toolbar, use the Option menu's Show Toolbar 
option. 

Editing Buttons 

 
Copy the currently selected calculation or project 

 
Paste a copied calculation or project into the currently selected folder 

 
Delete the currently selected calculation or project 

 
Interrupt the current Copy/Paste/Delete/Navigation operation--helpful if the 
server hangs or if you change your mind during a long operation such as copying a 
large project hierarchy. The stop sign icon turns red when one of these server 
operations is under way. Otherwise the Interrupt button is inactive (grayed out). 

Note: When you click the Interrupt button, Ecce stops waiting for the server 
operation to complete. This does not necessarily cancel the operation on the 
server. The actual result depends on the operation that was interrupted. For 
example:  
Interrupt... Result 
...deleting a large project hierarchy Some files will be deleted while others 

won't. 
...copying a large project hierarchy Some files will be copied while others 

won't. 
...opening a large project hierarchy The project will not be opened. 
...finding projects or calculations 
(below) 

The Find operation is canceled. 
  

Project Tree Navigation Buttons 

 
Find project or calculation name(s) that contains a specified case-sensitive string 
of characters (same as the Find option on the Calculation menu). This prototype 
searching capability can be slow when performed over many projects and 
calculations. To cancel a Find operation, use the Interrupt button. 

 
Back to the previously selected project--helpful when you switch between projects 
that are widely separated in the project tree 

 
Up one level in the project tree from the currently selected folder 

 
Forward to a previously selected project (after using the Back button) 



Ecce Version 3.2.2 Users Manual 

 22

Project Tree and Workspace 

The project tree (left pane) of the Calculation Manager window shows a hierarchy of 
folders that represent projects or collections of projects. You always have access to 
projects stored in the "share" folder or in your own folder, which is located within the 
"user" folder. Access to other project folders may require additional authentication. 

A single calculation can be moved by dragging it to a destination project folder in the tree 
view. The Calculation Manager supports copy-and-paste or drag-and-drop operations 
across data servers or authentication realms. This is useful to move data from one server 
to another (for sites using multiple data servers) or to copy data to the share area for 
others to view. 

The project workspace (right pane) of the window lists the contents of the folder selected 
in the project tree. To show the contents of a project folder, click on the project name or 
folder icon in the project tree—or double-click on the project name or icon in the right 
pane. 

When the selected project contains calculations, the workspace lists each calculation by 
name in a table of calculation properties with other descriptors such as the "Creation 
Date" and the "Application" (computational code).  

How to...   Manage Projects and Calculations

Icons in the workspace indicate the "Type" of item and some other calculation properties. 

Descriptor Icons What the Icons Mean 
 Project folder for containing calculations and subprojects 
 Ecce calculation (not associated with an application) 
 Amica calculation 
 Gaussian calculation 

Type 

 NWChem calculation 
State 

 

 

 
 

Calculation run state icons indicate (by their shape and color) the 
preparation or processing state of Ecce calculations--such as 
"created" or "running" or "completed."  
See... Legend of Calculation Run States 

Reviewed  Check mark in the Reviewed column indicates that the calculation 
has been reviewed in the Calculation Viewer. 

Annotation 
or 
Citation  

 Check mark for these properties indicates that an annotation or 
citation has been created for the calculation. 
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You can customize the appearance of the workspace to suit your purpose: 

• specify date and time formats  
• specify the selection and order of properties columns  
• always show the "Type" and "Name" columns  
• click a column heading to sort by the column contents  
• and change the colors of the calculation state icons.  

How to...  Display Calculation Properties 
   Customize the Calculation Manager Display

Menu Bar 

Each of the menus on the menu bar can be "torn off" as an independent window that 
remains visible while you work. To "tear-off" a menu, open the menu by clicking on the 
menu title and then choose the dashed line that separates the menu title from the menu 
options.  
Tip: Open any menu from the keyboard by using the Alt+underlined letter combination 
(for example, Alt+h opens the Help menu). Then select a menu option by pressing the 
letter that corresponds to the option.  

- Calculation Menu 

The Calculation menu enables you to create, import, and delete calculations as well as 
create and delete projects. 

New 
Calculation 

Create a new calculation within the currently selected project. If no project 
is selected, this option will appear disabled on the menu. 

New Project Create a new project folder for containing calculations or other new 
subprojects. The new project appears as a folder in the current project 
workspace. 

Import 
Calculation 

Import a previously run calculation that was generated outside of the Ecce 
user interface. 

Delete Delete the selected project or calculation (and all associated files and 
directories) from the project tree and workspace. 

Find Find project or calculation name(s) that contains a specified case-sensitive 
string of characters. This prototype searching capability can be slow when 
performed over many projects and calculations. To cancel a Find 
operation, use the Interrupt button. 

Quit Close the Calculation Manager window.  
Tip: To end an Ecce session and close all tool windows at once, close the 
Gateway.  
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- Edit Menu 

The Edit menu enables you to perform various cut and paste operations on the item 
currently selected in the project workspace of the Calculation Manager window. 

Duplicate Make a duplicate of a project or calculation and place it at the same 
level in the project tree as the original item. The Duplicate operation 
reproduces the input files of calculations but NOT the output files of 
any finished calculations: if a project contains finished calculations, 
the duplicated project will contain similar calculations that are ready 
to run.  
Note: The Duplicate operation is functionally the same as a 
Copy/Paste operation (below) except that Copy/Paste allows you to 
place the new project or calculation anywhere in the project tree.  

Duplicate Setup 
with Last 
Geometry

Duplicate the inputs of a completed geometry optimization calculation 
(as above), but use the chemical system geometry from the final step 
of the selected calculation.  
Note: If the selected calculation is not completed geometry 
optimization, you may see a warning in the message area. The 
duplicated calculation would be the same as it would be after the 
Duplicate operation.  

Copy Copy a project or calculation into the cut/paste buffer for pasting into 
another project. 

Paste Insert a copied item into the currently selected project. 
Annotation... Bring up the UNIX default editor in order to enter/edit/view text in a 

special file that is associated with a given project or calculation. This 
Annotation option is the only way to access this information. The only 
way to remove an annotation is to delete all annotation text.  

Citation... Bring up the UNIX default editor in order to enter/edit/view a 
literature citation that is associated with the selected item. The only 
way to remove a citation is to delete all citation text. 

Preferences... Open the Preferences window for customizing the appearance and 
operation of the Calculation Manager. Options include the selection 
and order of calculation properties displayed and the formats for date 
and time. Use the Access Control tab to selectively grant read or read-
write access to other users for project data you own. By default only 
the owner of the data has read-write access. The access permissions 
you set remain in effect until you change them.  
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- Options Menu 

The menu includes items for controlling how the tree hierarchy is sorted along with some 
display and operating options previously found within the Calculation Manager's 
Preferences window. Click on a toggle button to turn the option on or off .  

Change Access 
Control... 

Open the Access Control dialog window to specify which Ecce users 
may have access to the contents of your project folders. You may grant 
access only to project folders that you have created. This window 
contains two fields for entering user names to grant access to the project 
folder that is currently open and displayed in the Calculation Manager: 
one field for "read-only" access and one field for "read/write" access. 

To grant access to all Ecce users, enter the keyword ALL instead of 
specific user names. To deny access to a project, just leave the fields 
blank. 

Picture... Access Control Window  
Sort Tree by> Sort the project tree by Name, Name (in reverse), Date, Date (in 

reverse), None (no sort order). 
Confirm 

Deletes 
Mark this option to see a confirmation dialog each time you delete 
projects or calculations. 

Confirm 
Resets 

Mark this option to see a confirmation dialog each time you reset a 
calculation. 

Show Toolbar Mark this option to show the Calculation Manager's option tool bar of 
editing and navigation buttons--including an Interrupt button for 
interrupting server operations that are unexpectedly long.  
More about... Calculation Manager Tool Bar 

Show Run 
State Legend 

Mark this option to show the legend of calculation run state icons across 
the middle of the Calculation Manager: 

 

 
More about... Legend of Calculation Run States 

Use Fixed 
"Type" and 

"Name" 
Columns 

Mark this option to maintain the Type and Name columns at a fixed 
position on the left side of the properties table in the Calculation 
Manager. 
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- Run Mgmt Menu 

The Run Management menu provides options for monitoring or halting the progress of a 
running calculation, resetting a calculation for a modifed run, and cleaning up files 
created by the calculation. 

tail -f  on 
Output File... 

Open an xterm window that shows the contents of the output file for the 
selected calculation so that you can monitor its progress in real time as it 
runs. The output file scrolls in the window as the calculation runs. 

shell in 
Calculation 

Run 
Directory... 

Open an xterm window into the scratch directory (on the machine that is 
running the calculation) where Ecce stores temporary files during 
processing. With the proper knowledge of UNIX and the computational 
code, you can monitor what is happening. 

Manage 
Files... 

Opens a window which shows a list of the files on either the Ecce data 
server or the compute server. You can View or Remove files at either 
location, or Copy specific files from the compute server to the Ecce data 
server.  

Terminate 
Calculation 

Kill a submitted or running calculation--or abort a calculation import in 
progress. Ecce may take half a minute to confirm that the job is 
terminated and display the killed (coffin) icon for that calculation. 

Check Job 
Monitoring 

Check whether job monitoring has failed for any calculations in the 
currently displayed folder. This detects errors that could not be caught by 
the monitoring process and reports them in the message area. Use this 
option if calculations seem to be hung in the submitted or running 
states. 

Reconnect Job 
Monitoring 

Re-establish the job monitoring process for a submitted or running 
calculation so that information displayed in the Calculation Manager is 
updated correctly. Use this option when job monitoring terminates before 
your calculation completes, which is usually indicated by the Monitor 
Error icon for the calculation. 

Reset to 
Rerun 

Reset the selected calculation to the "ready" state and delete any data 
associated with previous runs, including all output properties and files on 
the run machine. 

Reset for 
Restart 

Reset the selected calculation to the "ready" state so that it can be 
restarted from Ecce. (Only the Ecce calculation state is changed. No 
chemical system properties or output files are deleted, and the input file 
remains the same.) After selecting "Reset for Restart" and before 
launching the calculation again, you must manually edit the calculation 
input file, specifying whatever "restart" keyword and supporting inputs 
are necessary for the current code.)  
Warning: If you do not modify the input file before launching a 
calculation that has been "reset for restart," then the calculation will 
begin again from the original starting geometry. This would pile a 
repeat set of properties on top of the ones already present for the 
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calculation in Ecce's data server--you don't want that!  
Reset State> Set the selected calculation to one of these run states:  

Reset to completed Processing is complete. 
Reset to incomplete Processing did not complete successfully. 
Reset to imported Calculation results were imported from an 

external source. 
Reset to killed Processing was canceled (coffin icon). 
These options enable you to set the state of a calculation that may have 
been incorrectly reported because of network or machine instability. 

Mark as 
Reviewed 

or 
Mark as 

Unreviewed 

Manually specify a selected calculation as either "reviewed" or 
"unreviewed" in the Calculation Viewer. Any calculation that has been 
opened and reviewed in the Calculation Viewer is automatically marked 
as reviewed.  
How to... Visually track which calculations have been reviewed  

Cleanup Run 
Directory 

Files 

Remove both the calculation and scratch directories from the machine 
where the selected calculation was run.  
It is good practice clean up these directories to conserve disk space on 
the machines where the calculations are run.  

View Run 
Log... 

Open a window that shows a log of messages generated by the system 
during the calculation processing--sometimes a useful tool for 
"debugging" a run. Run logs are in XML (extended markup language) 
format.  
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- Tools Menu 

The Tools menu provides access to a variety of tools that can operate on calculations. 

Builder... Start the chemical system Builder tool using the chemical system from the 
currently selected calculation. (Or if the chemical system is not yet 
specified for the calculation, use the Builder to create or choose a 
chemical system.) 

Calculation 
Editor... > 

Start the default Calculation Editor tool for editing inputs to the currently 
selected calculation--or open a specific Calculation Editor from a 
submenu of computational code options:  
NWChem... Open the NWChem Editor. 
Gaussian-98... Open the Gaussian-98 Editor.
Amica...  Open the Amica Editor. 
If the calculation is NOT yet associated with a specific code, the 
Calculation Editor opens in the context of the chosen computational code 
and displays parameter options specific to that code. 
If the calculation IS aready associated with a different code, Ecce first 
prompts to confirm whether to change the code for the calculation. 
Calculations that are in a read-only state (such as submitted, running, or 
completed calculations) are not switchable between computational codes. 

Basis Set 
Tool... 

Start the Basis Set tool for assistance in specifying a basis set for the 
currently selected calculation. 

  
Job 

Launcher... 
Start the Job Launcher tool for submitting a ready calculation to a 
computer for processing. 

Calculation 
Viewer... 

Start the Calculation Viewer tool for the currently selected calculation. 
This tool summarizes all information for a calculation and can display 
graphic visualizations of such things as the chemical system, molecular 
orbitals, or a set of vibrational normal modes. 

View Input 
File... 

View the contents of the input file for the currently selected calculation. 

View Output 
File... 

View the contents of the output file for the currently selected (and 
completed) calculation. 
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- Help Menu 

The Help menu provides access to this online help and enables you to supply feedback 
about your experience with Ecce.  

Help on 
this tool 

Show online help information for this tool or window. 

Support Display a form for providing support requests to your onsite Ecce 
representative or adminstrator about problems, questions, or other comments. 
Note: Although your onsite Ecce administrator should be your first choice 
for problems and questions, you may address feedback or suggestions to the 
Ecce development team at ecce-support@emsl.pnl.gov.  

Legend of Calculation Run States 

 

Each calculation within a project in the Calculation Manager can be marked by a small 
colored icon that indicates the state of the calculation by the icon color and shape. The 
legend shows the icons associated with each of the nine possible calculation run states. 
You can hide the legend by opening the Options menu and unmarking Show Run State 
Legend. 

The nine calculation states are defined as follows: 

Created  Calculation is in preparation and has been saved on Ecce's data server. 
Ready  Calculation is defined and ready for submission to a machine. 

Submitted  Calculation has been submitted for processing on a machine. 
Running  Calculation is currently being processed on the designated machine. 

Completed  Processing is complete. 
Imported  Calculation results were imported from an external source such as the 

code output results of a calculation processed outside of Ecce. 
Killed  Processing has been canceled (coffin icon). 

See also ... Terminate Calculation in the Run Mgmt menu. 
Incomplete  Processing did not complete successfully. 

Monitor 
Error 

 Calculation monitoring has failed or encountered errors after 25 attempts 
to restart and continue monitoring. When a calculation has this state, open 
the Run Mgmt menu and use View Run Log to identify the problem by 
scanning for an error at the end of the run log. 

System 
Error 

 Job has failed during monitoring due to the current status of the machine 
(such as a machine being taken off the network for maintenance). 
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The colors shown here are the Ecce default colors. You can modify these run state colors 
for your own use by using the Preferences option from the Ecce Gateway. 

How to... Set Color Preferences 

Window Footer 

At the bottom of the window is a footer that displays the following status information: 

• the UNIX pathname to the current folder selected in the project tree  
• a message area for system prompts and messages  

More about... Items in the Ecce Window Footer.
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Overview - Builder 

The Builder enables you to build, visualize, modify, and manipulate 3D images of 
chemical systems to be used in Ecce calculations. The Builder can handle large chemical 
systems of tens of thousands of atoms—up to the practical limits imposed by your 
machine memory and processor. (The Builder has been successfully tested rendering 
1,000,000 wireframe atoms on a Linux workstation with an ATI Fire GL X1 graphics 
card. Results will vary, depending on your graphics hardware and display driver.) 

In the Builder's work area, a molecule can be constructed by  

• building up from nothing, atom-by-atom  
• building symmetric molecular systems with the Symmetry Toolkit  
• modifying prebuilt structures from an extensive molecular structure library  
• modifying and building very large systems with the MD (Molecular Dynamics) 

Toolkit  
• importing structures from an external file, including large Protein Data Bank 

residues.  

Measurement-adjustment tools are available for fine-tuning the position and spacing of 
atoms in chemical systems. The atomic coordinates of created molecules are used by 
other Ecce tools in calculations and can be exported to external files in various molecular 
modeling formats.  

Learning the Builder. Although the Builder can easily be used to perform simple tasks, 
its many functions make mastering this tool a more difficult assignment than most other 
Ecce tools. This overview describes the Builder's components and controls. 

See also...  Examples: Building Chemical Systems 
   Builder Quick Reference - a one-page guide and "icon demystefier" for the 

Builder interface 
Tip: As you work in the Builder, watch the message area at the bottom of the window for 
brief instructions about using Builder features. 

Key Concepts 

• Constraints: Although the Builder has some defaults that are guided by 
chemistry conventions, you are free to override them. In general, the Builder lets 
you build the molecules you can imagine (from the conventional to the 
outrageous).  

• Standalone Molecule Builder: The Builder can be downloaded and installed as a 
standalone molecule builder independent of the other Ecce software. This may 
be useful if you want to use the 3-D direct manipulation molecule building 
capability but are not interested in the rest of Ecce's graphical interfaces for 
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setting up, running, and viewing the results of electronic structure calculations. 
All building features supported in the Ecce-integrated version of the Builder are 
also available in the standalone version. The File menu Import… and Export… 
options are used to open and save chemical systems. The few options that require 
the context of an Ecce calculation are absent from the standalone Builder.  

• Calculations: If you are using the Builder with Ecce (rather than as a standalone 
molecule builder), then at some point the chemical system that you build must be 
saved as an input to a specific Ecce calculation. You can create the calculation 
first in the Calculation Manager and start the Builder in the context of that 
calculation, or you can build the chemical system first and then use the Builder's 
File/Save As option to create a new calculation for the Calculation Manager.  

• Modes of Operation: Generally you will click on a button that selects a mode of 
operation for actions in the Builder work area. For example, clicking on an 
element button puts the Builder in "Atom" mode for adding atoms to the work 
area. Or clicking on the button puts the Builder in "Select" mode for selecting 
atoms and bonds for further operations. 

 
To help you keep track of the mode, the selected control button is highlighted 
with a green border, and the corresponding mode is labeled at the top of the work 
area. 

• Selecting Atoms: The left mouse button is used in Select mode to select atoms 
for further operations. Selected atoms are highlighted in pink (well, fuschia really).  

 Select a single atom. 
Shift +  Select multiple atoms, one at a time. 

More about... Selecting Items in the Work Area
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Starting the Builder 

 

Ways to start the Builder: 

• In the Ecce Gateway: Click on the Builder icon (above) to open the Builder. If 
the Builder is already running, clicking on the Builder icon will bring its window 
to the front. To start a separate instance of the Builder, shift-click on the icon. 

• In the Calculation Manager: First select a calculation. Then choose Builder 
from the Tools menu.  

• In the Calculation Editor: Click on the Chem Sys button located in the upper 
left portion of the window.  

• As a standalone application: Enter the command ebuilder (all lowercase) at the 
UNIX or LINUX prompt. On the Builder's File menu, use the Import/Export 
options to open and save chemical system data.  

Work Area 

The image viewer on the right side of the Builder window contains the work area where 
chemical systems are constructed and modified. 

Picture... Work Area 

- Name / Charge / Symmetry 

Just above the work area are fields for assigning a chemical system name, assigning an 
overall charge, and displaying the associated symmetry group. 

• Name (optional): The name is used for reports and screen displays that call for a 
chemical system name (such as the structure library).  

• Charge (optional): To assign a charge, just type an integer value or select a 
common choice from the pull-down menu.  

• Symmetry (display only): If a symmetry has been found or assigned in the 
Builder's Symmetry Toolkit, the symmetry is displayed in the Symmetry field. If 
no symmetry has been found or specifically assigned, the symmetry displayed is 
C1 (no symmetry).  
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- Work Area Tools 

Along the left side of the work area are five tool buttons that have the following key 
functions in the Builder. 

Button Purpose 

 
Select - Switch to the Select mode cursor (arrow) for selecting atoms and groups 
of atoms in the work area.  
How to... Select Items in the Work Area
Tip: Keyboard Shortcuts  
Esc 
key 

Toggle quickly between the Select and Manipulate modes. 

Alt 
key 

In Select mode, switch the cursor to the Manipulate cursor as long as 
the Alt key is depressed.  

Note: The mode label in the Builder's work area may not change when you use 
these keyboard shortcuts.  

 
Manipulate - Switch to the Manipulate mode cursor (hand) for rotating the 
chemical system in arbitrary directions around a center point (  left mouse 
button).  
Note: It's a fine point, but these hand-cursor operations (like the thumbwheels) 
really manipulate only your viewpoint, NOT the items in the work area. Their 
space coordinates remain constant. In contrast, see 3D Manipulators and 
Construction Tools. 

Tip:In Manipulate mode only--depress the middle mouse button and drag to 
move (translate) the system in the (x,y) plane of the work area.  

 
The cursor switches to the Translate cursor (hand with object) in the 
work area.  

Tip: In Manipulate mode only--depress the  left + middle mouse buttons 
together (or Ctrl + ) and drag to dolly/zoom in the work area.  

 
The cursor switches to the Dolly cursor (pointing hand) in the work area.

  

 
Clean (broom icon)- Apply a simple molecular mechanics force minimization to 
improve the structure of molecules that have been built by hand. The Clean 
operation is based on the Universal Force Field (UFF) of Rappe and Goddard. 
The speed of this operation depends on the number of atoms. If no atoms are 
selected when the clean button is activated, then all atoms are optimized. If a 
subset of atoms is selected, then only the coordinates of the selected atoms are 
updated, although the remaining atoms are included when evaluating the forces 
on the atoms. The clean function can be slow for large systems, even if only a 
few atoms are selected. 

 
Orthogonal Plane Views - Open a separate window for viewing the current 
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chemical system in the x-, y- or z-plane. If you open two or three of these 
windows with different views, you can more easily judge the results of 3D space 
manipulations. 

 
Drag Site - This is not a command button but a starting site for dragging the 
contents of the work area from the Builder to other Ecce tools. For example, if 
you have a newly created calculation under way in the Calculation Editor, you 
can use the middle mouse button to drag (the current molecule) from this drag 
site onto the drop site of the Calculation Editor. 

- View Controls 

Along the right side of the work area and below it are controls for manipulating your 
view of items in the work area.  

Button Purpose 

 
Home - Reset the chemical system in the work area to a "Home" orientation.  
Tip: Keyboard Shortcut  
Home key Reset to "Home" orientation like the Home button.   

 
Set Home - Establish the current chemical system orientation as the "Home" 
setting. 

 
View All - Scale and center the chemical system to bring all components within 
the work area. 

 
Seek - Switch to the Seek cursor (cross hairs) for selecting an object as the view 
center point of the chemical system. After selection, the cursor returns to its 
previous mode. 

 
Perspective View - This button indicates that the work area is showing a 
perspective view: "closer" objects appear relatively larger. Clicking on this button 
toggles the work area (and the button's icon) to the ortho view. 

 
Ortho View - This button indicates that the work area is showing an orthogonal 
view: objects appear a constant size, regardless of their front-to-back positioning. 
Clicking on this button toggles the work area (and the button's icon) to the 
perspective view. 

 
The following "thumbwheel" controls (  + drag) manipulate your view of items in the 
work area. 
Control Purpose 
Dolly/Zoom In perspective view, this thumbwheel is labeled "Dolly" and moves the 

point of view into (or out of) the depth of the work area. In ortho view, this 
thumbwheel is labeled "Zoom" and merely enlarges or shrinks the size of 
the work area image.  
T ip: In Manipulate mode only--depress the  left + middle mouse buttons 
together (or Ctrl + ) and drag to dolly/zoom in the work area.  
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The cursor switches to the Dolly cursor (pointing hand) in the work 
area.   

X  This thumbwheel rotates the chemical system around the horizontal (X) axis 
at the current center of rotation. 

Y This thumbwheel rotates the chemical system around the vertical (Y) axis at 
the current center of rotation. 

Z This thumbwheel rotates the chemical system around the orthogonal (Z) 
axis at the current center of rotation.  
T ip: To display X-Y-Z axes and make the thumbwheel rotations more 
clear, open the View menu and mark Axes.  

Menu Bar 

Each of the menus on the menu bar can be "torn off" as an independent window that 
remains visible while you work. To "tear-off" a menu, open the menu by clicking on the 
menu title and then choose the dashed line that separates the menu title from the menu 
options.  
Tip: Open any menu from the keyboard by using the Alt+underlined letter combination 
(for example, Alt+h opens the Help menu). Then select a menu option by pressing the 
letter that corresponds to the option.  
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- File Menu 

The File menu enables you to: 
Save Save the current chemical system to the current calculation.  

Tip: For a shortcut way to save the chemical system, click on the 
"Save Work" icon . The icon appears in the window footer 
whenever you add or modify items in the work area. 
If you launched the Builder directly from the Gateway, the Save 
option will be disabled because there is no specified calculation to 
which the chemical system can be saved. In that case, you can either 
drag a molecule from the Builder onto the drop site of a Calculation 
Editor window or use the Save As option to save the chemical 
system in a new calculation. 

Save As... Open a file dialog window for saving the current chemical system as 
part of a new calculation within an existing or new project folder. 

Record/Playback... Open a command recorder (prototype) for recording and saving a 
sequence of Builder commands to automate Builder tasks. You must 
specify a writeable location for an XML file that stores the 
commands.  

Import... Open a file dialog window for importing a chemical system from a 
file. You must specify the format of the file to be imported. Ecce 
currently supports several file import formats: Alchemy (TRIPOS), 
MVM, PDB (Protein Data Bank), XYZ, and others . The XYZ 
format consists of a line with the total number of atoms, followed by 
a comment line and lines with an atomic symbol (H, Li, etc.) and the 
(x,y,z) coordinates in angstroms.  
Tip: If you import a chemical system that does not have explicitly 
defined bonds, you can use the Builder's Generate Bonds option to 
create bonds based on the distances between atoms and a table of 
standard covalent radii.  

Export... Open a file dialog window for exporting a chemical system to a file 
in the four formats listed above. Additional formats are available for 
exporting the chemical system as a graphics file (Postscript, RGB, 
GIF, TIFF, JPEG, and PICT). 

Print... Open a window for printing the contents of the work area on a 
selected printer. You can select from a scrolling list of available 
printers.  

Quit Quit the Builder. If you have created a chemical system and have not 
saved your work, you will be prompted to do so.  
Tip: To end an Ecce session and close all tool windows at once, 
close the Gateway.  
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- Edit Menu 

The Edit menu enables you to: 
Undo 

[last operation] 
Undo Builder operations. For large chemical systems (> 1000 atoms) 
the number of operations available to "undo" may be limited. For 
especially large chemical systems, the Undo capability may be 
disabled. 

Cut Selection Remove any atoms that are currently selected in the work area, leaving 
nubs on any remaining atoms that were bonded to the removed atoms. 
This option is enabled only when some part of a chemical system is 
selected (highlighted). The cut operation places the deleted atoms into 
the cut/paste buffer. 

Copy Selection Move the selected atoms into the cut/paste buffer. 
Paste Paste the atoms currently in the cut/paste buffer onto the work area. 

Once the atoms appear in the work area, you can position them 
wherever you wish. 

Clear Clear the work area. 
Delete Selection Remove the selected atoms without placing them in the cut/paste 

buffer. 
Select All Select all atoms in the work area. 

Select Molecule Select the entire molecule or fragment associated with a single 
selected atom.  

Reverse 
Selection 

Unselect all currently selected atoms, and select all currently 
unselected atoms in the work area.  

Unselect All Unselect all atoms in the work area. 
Select Within 

Radius... 
Select all atoms or residues within a defined radius of currently 
selected atom(s). 

- Display Menu 

The Display menu controls how the atoms and bonds of a chemical system are depicted 
in the work area. 

Style (All) > Choose from a submenu to select a general display style for depicting 
atoms and bonds in the work area. (See also Details on this Display 
menu.)  
Ball & Stick Ball & Wireframe 
Stick (bonds) Wireframe (bonds) 
CPK (space filling) Picture... Atom/Bond Styles 

Style (Selected) > Choose from a submenu to select a display style for depicting all 
selected atoms and bonds in the work area.  
Ball & Stick Ball & Wireframe
Stick (bonds) Wireframe (bonds)
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CPK (space filling) Invisible  
Render Quality > Choose from a submenu to select a quality level for rendering the 

atoms and bonds in the work area.: (See also Details on this Display 
menu.)  
High  Medium 
Low Very Low

As the rendering quality decreases, the 
rendering/display speed increases. 

Customize... Open a window of chemical system display 
attributes for modifying the appearance details of 
atoms and bonds. If the molecule is being rendered 
as a wireframe, you can control the line width. If 
you're using stick rendering, you can control the 
appearance of the stick endcaps, their quality, and 
their radius. Other options control the Ball & Stick 
quality.  
Picture... Customize Details: Chemical System 

Display Options   
Render As > Choose from a submenu to select how to render the surfaces of atoms 

in the work area:  
Normal solid surface 
Mesh polygon lattice
Dots dot lattice  

Move as > Choose from an identical submenu to select which image rendering 
style (above) is used as you move and manipulate the chemical 
system.  
Note: This may be useful for speeding up the manipulation of a 
chemical system on slow hardware. Depending on your computing 
platform and details settings (below), the manipulation of the 
chemical system may be faster and smoother with Mesh or Dots.  

Selected atoms Display only items that are selected in the work area. Unselected 
items are invisible. 

All atoms Display all items in the work area, cancelling any display limited by 
selected atoms. 

Stereo Mark this option to see a stereo 3D image of the chemical system on 
workstations equipped with CrystalEyes® stereo viewing glasses.  
Note: The monitor must first be enabled for stereo viewing by using 
a hardware-specific display command .  

Depth Cueing Mark this option to simulate depth perspective: closer objects appear 
brighter than more distant objects. This is especially useful for 
viewing larger molecules. 

Transparency When this option is marked, objects in the work area become partially 
transparent so that you can see how objects overlap. 
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- View Menu 

The View menu enables you to show or hide hydrogen atoms and various labels in the 
work area. It also provides an option to view the geometry in a tabular format. 

Hydrogen 
Atoms 

Show/hide hydrogen atoms in the work area (if any). 

Atom Labels > Choose what labels appear on atoms in the work area. The "Atom 
Name" and atom "Type" labels may be modifiable in the Geometry 
Table described below. If the information has not been assigned, the 
corresponding label will not appear. 
None Element with number
Atom Name Charge 
Type    

Bond Labels Show/hide labels for all bonds in the work area. 
Axes Show/hide a set of Cartesian axes that can be used as visual indicators 

within the work area. 
Geometry 

Table... 
Display a table of geometry information and other details about the 
atoms of the current chemical system. The table displays atomic 
symbols, Cartesian coordinates, and Protein Data Bank (PDB) 
information if available. Selecting and highlighting row items in the 
table will select and highlight the corresponding atoms in the work area. 
Picture... Geometry Table 
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- Options Menu 

The Options menu enables you to generate bonds for imported chemical systems, control 
details of the "clean" operation, set background and labels colors, and use the special 
display features of the work area. 

Edit 
Background 

Color... 

Open a color chooser window for modifying the background color of 
the viewer work area.  
Picture... Background Color Chooser Window 

Edit Atom 
Label Color... 

Open a similar color chooser window for modifying the color of the 
labels (atomic symbols, bond lengths, etc.) in the work area. 

Generate 
Bonds 

If you import a chemical system, it may not have any existing bonds 
defined, depending on the format of the file. This option attempts to 
create bonds based on the distances between atoms and a table of 
standard covalent radii.  
Tips: About generating bonds  

You can control the bond generation by adjusting the bond 
formation tolerance and covalent radius associated with each 
element by using the Builder's Periodic Table tool (which is opened 
by the more... button in the Builder).  
How to... Set radii preferences for generating bonds  
You can the edit the generated bond types with the bond types 
palette. 
If a multiple bond to hydrogen is encountered during bond 
generation, only the shortest bond is generated. This prevents 
spurious bonds from appearing in hydrogen-bonded structures (such 
as double-stranded DNA). If you are interested in structures such as 
boron hydride, you can still store them without losing bonding 
information by saving them in MVM format.   

Generate 
Hydrogen 

Bonds 

Determine where hydrogen bonds should exist and display a distance 
measure between the affected atoms and the corresponding hydrogen 
atoms. 

Recenter 
Coordinates 

Center the chemical system around its center of mass and scale the 
display to show all components within the work area. 

Clean 
Parameters... 

Open a window for setting parameters related to the "clean" operation. 
The clean operation automatically improves crude guesses to the 
molecular geometry when you click on the "Clean" button . The 
parameters include the maximum number of line searches (steps), the 
convergence on the gradient, and the cutoff distance for computing non-
bonded interactions. 

Auto 
Normalize 

Display 

When this option is marked, the Builder recenters the chemical system 
as you work, continually orienting and scaling the chemical system to fit 
in the work area as you add or subtract structures. 
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Enable 
Spinning 

When this option is marked, you can use the Manipulate mode cursor 
(hand) to impart a spin to a chemical system around its center of mass. 
To stop the spin, click anywhere in the work area. Unmark this option to 
prevent accidental spinning. This option is saved as a preference that 
remains in effect until you change it. 

Torsion: 
Rotate Group 

When this option is marked, any adjustment using the torsion tool will 
move all atoms connected to atom 3 (the third atom selected). When this 
option is NOT marked, any adjustment of torsion angle will move only 
atom 4 and all atoms connected to atom 4. 
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- Toolkits Menu 

The Toolkits menu provides access to toolkits for building special kinds of chemical 
systems. 

Symmetry 
Toolkit... 

The Symmetry Toolkit in the Ecce Builder has extensive capabilities for 
constructing symmetric molecular systems: 

• automatic symmetry group recognition  
• reduction of a symmetric system into a unique set of atoms  
• generation of a complete molecule from a unique set of atoms  
• a "symmetry clean" function that takes an approximately 

symmetric configuration and applies a set of coordinates that are 
symmetric to numerical precision  

• additional tools for aligning atoms to particular axes and planes  
• pre-loaded sets of ghost atoms for each symmetry group (for 

constructing symmetric systems and for indicating the location of 
the principle symmetry axes and planes for each point group).  

Picture... Symmetry Toolkit Window 
Examples... Building chemical systems with the Symmetry Toolkit 
More About... Symmetry Toolkit - overview of window and controls  

MD Toolkit... The Molecular Dynamics Toolkit in the Ecce Builder enables you to 
construct very large molecules by means of a number of techniques and 
tools:  

• import PDB files to create internal residues  
• structure analysis and validation  
• insert/edit/delete residue  
• assign residue atoms  
• write segment or fragment files  
• add hydrogens to the cleaned-up molecule  

Picture... Molecular Dynamics Toolkit Window 
More About... MD Toolkit - overview of window and controls  

Trajectory 
Toolkit... 

The MD Trajectory Toolkit enables you to import a trajectory file and to 
view and save the animation. The Trajectory Toolkit supports the 
NWChem MD trajectory format, and the Ecce input 0.2 XYZ geometric 
format. 
For more information on animation, molecular dynamics and NWChem 
files, see the NWChem User Manual Chapters 22, 27, and 30. 

Partial 
Charge 
Toolkit 

The Partial Charge Toolkit enables you to set up partial charge 
calculations. The toolkit sets up the calculation to derive partial atomic 
charges that fit the quantum mechanical electrostatic potential on selected 
grid points.  
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DNA Builder 
Toolkit 

The DNA Builder Toolkit enables you to easily create DNA molecules by 
selecting from a list of base pairs.  

- Help Menu 

The Help menu provides access to this online help and enables you to supply feedback 
about your experience with Ecce.  

Help on 
this tool 

Show online help information for this tool or window. 

Support Display a form for providing support requests to your onsite Ecce 
representative or adminstrator about problems, questions, or other comments. 
Note: Although your onsite Ecce administrator should be your first choice 
for problems and questions, you may address feedback or suggestions to the 
Ecce development team at ecce-support@emsl.pnl.gov.  

Element/Geometry Palette 

This button palette is used like a painter's palette to add atoms in the work area. It 
includes element buttons for choosing the type of atom and geometry buttons for 
choosing the bond hybridization/coordination number. 

See also... Bond Types 
 

 

To add a new atom, you must first "load the cursor" with an element--
something like a painter loads a paintbrush with paint. That is, click on an 
element button (or a geometry button, which is automatically associated 
with an element) and then click on the work area to add a new atom. Each 
element has a default hybridization or coordination number. 

For example, if you click on the carbon button, the geometry button for tetrahedral (sp3) 
hybridization also appears depressed. The C button will have a highlighted border around 
it, and a label in the work area will indicate "Atom" mode. Each subsequent mouse click 
inside the work area will add a carbon atom at the clicked location. If you click on one of 
the bond nubs (bonding sites) of a previous atom, the new carbon will be bonded to the 
previous atom. After an element button is selected, you can switch to a different 
hybridization/coordination number by clicking on a different geometry button.  

If you want to use an element or hybridization/coordination number that does 
not appear on the basic palette, you can bring up other options with the more... button. A 
new window will appear with the entire periodic table and 12 geometry schemes. When 
you click on an element in the periodic table, that element will fill in one of the two blank 
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buttons in the element palette. Similarly, when you click one of the 12 geometry buttons, 
the corresponding icon for that hybridization or coordination number will fill in one of 
the two blank buttons in the geometry palette. The current version of Ecce allows only 
two user-specified elements on the element palette and two user-specified 
hybridizations/coordination numbers on the geometry palette. In each case, choosing a 
third item will cause the first item to be removed.  

Picture... Periodic Table and Additional Bond Geometries
More about... Features of the Periodic Table 

Add/Remove Hydrogens 

 Add hydrogens at all empty nubs. 

 Replace all hydrogens with empty nubs.

Bond Types 

The bond palette enables you to specify a bond type for bonds formed between atoms in 
the work area. The bond types used will affect the "clean" operation, which adjusts the 
molecular geometry when you click on the "Clean" button . The bond type buttons are 
disabled until the first atom is added in the work area.  

 

The currently supported bond types are 1) single bonds, 2) 
double bonds, 3) triple bonds, 4) aromatic bonds and 5) metal-pi 
bonds. 

The conventional bonds (the first 4 types) all work the same way: 

• After you click on one of the bond type buttons, that bond type will be used for 
new bonds in the work area. For example, if you want to build a molecule with 
doubly bonded carbons, you can click on the double bond button and then click 
on the C button.  

• To add a new atom and bond simultaneously, click on a bonding site or "nub" of 
an atom in the work area.  

• To create a bond between two atoms already in the work area, first click on the 
bond type button and then select two atoms (or vice versa). One bond nub is used 
from each atom.  

• To change an existing bond to a conventional bond type, first click on the bond 
type button and then click on the existing bond (or vice versa).  

The metal-pi bonds work differently in these ways: 

• After you click on the metal-pi button, your only option is to add a metal-pi bond 
between two existing atoms.  

• Metal-pi bonds ignore bond nubs.  
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• You cannot convert a conventional bond type to a metal-pi bond.  

Bond types are depicted only in the wireframe style of rendering. With other styles you 
won't be able to see a difference between the different bonds. 

Tip: You can use the Geometry Table to monitor details of the bonds created between 
atoms. 
 
Note: If you import a chemical system, it may not have any existing bonds defined, 
depending on the format of the file. The Generate Bonds option of the Options menu 
attempts to create bonds based on the distances between atoms and a table of standard 
covalent radii. 

Structure Library 

As an aid in constructing larger molecules, the Ecce Builder has an 
extensive collection of molecules contained in a structure library. These molecules can 
be easily added to the work area. The Structure Library button (located below the 
element/geometry palette) opens the Structure Library window. The Builder then 
switches into "Add Structure" mode. 

In the Structure Library window you can choose from a number of pictured molecules by 
clicking on the name of a molecule. Then as long as you are in "Add Structure" mode, 
each mouse click in the Builder work area will add the selected molecule at the clicked 
location. The Structure Library tool includes options for creating your own structure 
libraries and for importing and exporting chemical systems to a structure library.  

Picture... Structure Library Window 
How to... Add Predefined Structures in the Builder

Create a Private Structure Library 
More About... Structure Libraries 

 



Ecce Version 3.2.2 Users Manual 

 48

Measurement-Adjustment Tools 

The four measurement-adjustment tool buttons below the Structure Library button enable 
you to display and modify atomic distances and angles, including dihedral angles 
(torsion). Measurements remain displayed in the work area until canceled by the Cancel 
Measurements button. 

Button Measurements Display 

 
Distance- After clicking on this button, select two atoms or a bond. The distance 
(in angstroms) between atom centers is displayed along a dashed line between the 
atoms. 

 
Angle - After clicking on this button, use Shift +  to select three atoms (one at a 
time) to define an angle. The measurement is displayed along a dashed line 
between the bonds. 

 
Torsion - After clicking on this button, use Shift +  to select four atoms (one at 
a time) to define a dihedral angle. The first three atoms define one plane, while 
the second three atoms define another plane. The measurement is displayed along 
with the planes that define the angle. 

 
Cancel Measurements - Remove all displayed measurements from the work 
area. The current operating mode is unaffected. 

Picture... Measurement Examples 
Tip: If the labels displayed by the measurement tools are obscured by atom surfaces, you 
may need to rotate the view, switch to a mesh rendering style, or make the atoms 
transparent to view the labels. 

To MODIFY the measured geometry: After displaying a measurement, click on the 
dashed line (for distances and angles) or dihedral plane (for torsion). A small dialog 
window then displays the current value of the corresponding measurement. If you enter a 
new value, the last atom selected will move to reflect the new geometry. 

Tip: Sun users: You may need to click in the entry field of the dialog window before you 
can type a value. 
See also... Torsion: Rotate Group on the Options menu 
  Alignment and Translation Tools in the Symmetry Toolkit 
  Geometry Table for editing atomic coordinates and partial charges 
  Examples of building chemical systems using the measurement-adjustment 

tools 
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3D Manipulators and Construction Tools 

The eight buttons located below the measurement-adjustment buttons enable you to move 
and rotate atoms in 3D space, create "ghost" atoms that make building certain types of 
molecules easier, and add dashed lines between atoms to highlight their relationship. 
These buttons occur in pairs. The upper button of each pair activates the option. The 
lower button (with a red X) erases the corresponding tool from the work area (but does 
not cancel the option). A highlighted border appears around any active tool button.  

Buttons Purpose 

 

 

Move & Rotate Atoms - When you activate this option, a single wireframe 
manipulator sphere will enclose atoms that are already selected. After this 
option is active, select single atoms (or several atoms together) to get additional 
manipulators.  
Picture... Manipulator Sphere

To move 
atoms in 

space

Click on the gridded surface of the manipulator sphere. While the 
mouse button is depressed, a double-ended arrow will appear 
through the center of the sphere, indicating the directions in which 
you can now drag and move the enclosed atom(s). It may take a bit 
of practice to become accustomed to using these manipulators. 

To 
rotate 

atoms in 
space

Click on one of the two green bands around the manipulator 
sphere. While the mouse button is depressed, you can rotate the 
sphere and the enclosed atom(s) along the direction of the selected 
band.  

 

 

Rotate About a Bond - When you activate this option, a wireframe manipulator 
wheel will appear at the center of the bond between two selected atoms. After 
this option is active, you can select any two atoms together to get an additional 
manipulator wheel. The first atom selected remains fixed. You can also select a 
bond instead of two atoms, but then the choice of the fixed atom is arbitrary.  
Picture... Manipulator Wheel

To rotate 
atoms about 

a bond 

Click in the region near the manipulator wheel. While the 
mouse button is depressed, you can rotate the atom(s) on one 
side of the bond while the other side remains fixed. During 
rotation, a box will appear around the bond axis to make it easier 
to judge the magnitude of the rotation.  

 

 

Ghost Atoms - After clicking on this button, you can click in the work area to 
position a "ghost atom" (a small placeholder ) at any point in 3D space as an 
aid to building a molecule. For example, sometimes it is helpful to position a 
ghost atom as a reference point at the center of a group of atoms. When you are 
finished and no longer need the ghost atom, just click on the X-Ghost Atom 
button.  
Picture... Ghost Atom 
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To position a 
ghost atom 

centered in a 
group 

First select a group of atoms (in Select mode). Then click on 
the Ghost Atom button. The ghost atom will appear at the 
center of the structure. Note that this method (as well as 
accidentally clicking on atoms in Ghost Atom mode) can 
create ghost atoms "inside" other atoms, where they may be 
hidden from view.  

 

 

Atom Lines - After clicking on this button, select two atoms to draw a dashed 
line between them. This can aid your perception of the 3D space. The lines 
could also be useful for complexes containing cations or anions: you could use a 
line to indicate an electrostatic interaction without actually specifying a formal 
bond.  
Picture... Atom Lines  

Window Footer 

At the bottom of the window is a footer that displays status information as well as a drop 
site for receiving calculation inputs that have been "dragged" from another tool: 

• the project path and name of the current calculation  
• a colored icon that indicates the current state of the calculation  
• a message area for system prompts and messages  
• "Save Work" Icon -  

If you see a star-shaped icon, this indicates that you have added or modified items 
in the work area but have not yet saved them. To save the current chemical system, 
just click on the star icon.  

• Padlock Icon -  
If you see a padlock icon, this indicates that the current calculation is locked. You 
will not be able save changes to the chemical system.  

•  

 
Drop Site - The "in-tray" square at the right side of the footer is a 
drop site destination for "drag & drop" operations. For example, you 
can use the middle mouse button to drag a calculation from the 
Calculation Manager and drop it on this site. 

More about... Items in the Ecce Window Footer 
How to... •  Display a Legend of Calculation State Icons

•  Drag & Drop with the Mouse 
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Overview - Structure Library 

As an aid in constructing larger molecules, the Ecce Builder has an extensive collection 
of molecules contained in a Structure Library. These molecules can be easily added into 
the Builder, where they can be used or modified for calculations.  

Note: The Structure Library files are included with the standalone Builder installation 
under the data/client/StructureLibrary directory rather than being located on the Ecce 
server.  

Key Concepts: Ecce's Structure Library of pre-built molecules resides in a shared 
"Structure Library" folder of the Ecce Web server (or in the data/client/StructureLibrary 
directory of a standalone molecule builder installation). For convenience, this shared 
folder is divided into subfolders or categories of molecules, such as amines, hormones, 
and steroids. In the Builder's Structure Library window you can select one folder in the 
folder tree and display images of the molecules in that folder in a graphic list of 
molecules. After selecting a molecule by clicking on its name (not on its picture), you 
can then add that molecule in the Builder by clicking in the Builder's work area. The 
name of the currently selected molecule in the Structure Library is highlighted. 

The Structure Library window includes options for creating a personal (user) structure 
library in your user folder and for importing and exporting chemical systems to and from 
the structure library that you create. You can even add a molecule from the Builder's 
work area to a structure library by using the Builder's drag & drop feature. 

Note: The siteconfig/GLLimits.xml file is used to configure limits on the number of 
simultaneous OpenGL viewers (graphic viewers) to display within the Builder Structure 
Library window. This file allows more control in specifying differences between versions 
of software such as Hummingbird Exceed/3D. The GLLimits.xml file contains more 
information about using this capability. If you want more OpenGL viewers (or less) for 
your software, check with your site administrator if you need adjustments to this file.  
 
How to... Add Molecule Structures in the Builder

Create a Private Structure Library 
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Starting the Structure Library Tool 

In the Ecce Builder, click on the Structure Library button. This 
opens the Structure Library window and puts the Builder into "Add Structure" mode. As 
long as the Builder remains in that mode, each mouse click in the Builder work area will 
add the selected molecule at the clicked location. 

Tip: If the Structure Library window becomes disabled (grayed out), you have switched 
modes in the Builder. To switch back to Add Structure mode, click on the Structure 
Library button in the Builder again. 

The following items briefly describe elements of the Structure Library window.  

Folder Tree 

The scrolling folder tree on the left side of the Structure Library window displays the 
subdirectories of the Ecce Web server. By selecting a folder in this tree, you can view 
molecules in the shared Structure Library folder (or any folder of the Ecce Web server). 

Graphic List of Molecules 

The scrolling panel of molecules on the right side of the Structure Library window shows 
pictures of the molecules in the selected library folder. By default they are pictured in 
order of increasing molecular weight. To select a molecule for adding in the Builder, 
click on the molecule name (not on its picture). The name of the currently selected 
molecule is highlighted.  

Each picture of a molecule is active, meaning that you can use the mouse to manipulate 
the images and change their rendering within the Structure Library window:  

Mouse & 
Cursor Result 

+ 
drag  

Rotate the molecule arbitrarily around a center point. 

+ 
drag  

Translate the molecule in the x,y plane. 

+ 
drag  

Dolly toward or away from the molecule. (Ctrl +  + drag is equivalent.)

 -- Display a pop-up menu with options for switching to a different display 
style: Ball & Stick, Ball & Wire, Stick, Wireframe, CPK (space filling).  
Picture... Display Styles  

Menu Bar 
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Each of the menus on the menu bar can be "torn off" as an independent window that 
remains visible while you work. To "tear-off" a menu, open the menu by clicking on the 
menu title and then choose the dashed line that separates the menu title from the menu 
options.  
Tip: Open any menu from the keyboard by using the Alt+underlined letter combination 
(for example, Alt+h opens the Help menu). Then select a menu option by pressing the 
letter that corresponds to the option.  

- Structure Menu 

Like the Builder's File menu, the Structure menu includes import/export options for 
transferring structures to and from an external molecular modeling format.  

New 
Library 

Creates a new subfolder of the currently selected folder to contain a structure 
library. Make sure you have selected the appropriate directory location where 
you want the new folder to be. A user structure library is a convenient way to 
access molecules that you use frequently or store molecules that you have 
built. The new folder will be named Structure Library. After you have added 
the new folder, double-click on the folder name to give it a new name 
indicative of the structures you will store in it. You can then copy/paste 
molecules from other structure libraries, import molecules from external files, 
or drag in molecules that you have created in the Builder.  
How to... Create a Structure Library 

Delete 
Library 

Deletes the user folder that is selected in the folder tree: that applies to any 
selected folder, not just structure library folders. You can delete only folders 
that you have created. Ecce asks you to confirm or cancel the deletion.  

Import... Open a file dialog window for importing a chemical system from a file. You 
must specify the format of the file to be imported. Ecce currently supports 
several file import formats: Alchemy (TRIPOS), MVM, PDB (Protein Data 
Bank), XYZ, and others . The XYZ format consists of a line with the total 
number of atoms, followed by a comment line and lines with an atomic 
symbol (H, Li, etc.) and the (x,y,z) coordinates in angstroms. 

Export... Open a file dialog window for exporting a chemical system to a file in the 
four formats listed above. Additional formats are available for exporting the 
chemical system as a graphics file (Postscript, RGB, GIF, TIFF, JPEG, and 
PICT). 

Close Close the Structure Library window (but remain in "Add Structure" mode for 
adding the last selected molecule).  
Tip: To end an Ecce session and close all tool windows at once, close the 
Gateway.  
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- Edit Menu 

The Edit menu supplies basic functions for building and editing a private structure library 
for your personal use. The cut/paste/delete operations require appropriate privileges to 
use the selected folder.  

Cut Remove the selected structure from the folder (keeping a copy in the cut/paste 
buffer). 

Copy Copy the selected structure into the cut/paste buffer for pasting into another 
folder. 

Paste Insert a copied or cut structure into the currently selected folder.  
Note: The Paste option is applicable for user folders but NOT for the public 
shared Structure Library.  

Delete Delete the selected structure from the folder. 

- View Menu 

The View menu enables you to order the molecules pictured in the graphic list of 
molecules based on either their sizes or names.  

Sort by     
  Size Order the pictured molecules by increasing molecular weight. 
  Name Order the pictured molecules alphabetically. 

- Help Menu 

The Help menu provides access to this online help and enables you to supply feedback 
about your experience with Ecce.  

Help on 
this tool 

Show online help information for this tool or window. 

Support Display a form for providing support requests to your onsite Ecce 
representative or adminstrator about problems, questions, or other comments. 
Note: Although your onsite Ecce administrator should be your first choice 
for problems and questions, you may address feedback or suggestions to the 
Ecce development team at ecce-support@emsl.pnl.gov.  
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Window Footer 

At the bottom of the window is a footer that displays status information as well as a drop 
site for receiving chemical systems that have been "dragged" from the Builder to be 
added to a structure library:  

• The scrolling message area displays system prompts and messages.  
•  

 
Drop Site - The "in-tray" square at the right side of the footer is a 
drop site destination for "drag & drop" operations. You can use the 

middle mouse button to drag a molecule from the drag site in the 
Builder and drop it on this site. If you are authorized to modify the 

current structure library folder, the molecule is added to the library.  
More about... Items in the Ecce Window Footer
How to... Drag & Drop with the Mouse 
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Overview - Calculation Editor 

The Calculation Editor enables you to specify many inputs to a calculation without 
needing to recall the syntax of a particular computational chemistry program (code). You 
can access most user-adjustable input parameters that control the chemical system and the 
type of calculation. 

To have the flexibility necessary for handling a wide variety of chemical systems, most 
computational chemistry codes support a large number of input parameters. Although 
many input parameters are automatically assigned reasonable default values by the codes, 
you must still choose nondefault values for at least a few parameters. And while these 
programs do support a similar set of methods, knowing the correct syntax is a nontrivial 
job because there is little or no standardization of the input commands. Thus, users tend 
to stick with familiar applications, even if the applications are not the most efficient for a 
particular kind of calculation. Learning the input syntax for a new code is seldom as 
straightforward as it might seem, and making a mistake in the input file can result in 
wasted computer resources or (even worse) incorrect results. 

The Ecce Calculation Editor relieves you of the chore of mentally juggling a large 
number of different input formats in order to perform many common types of 
calculations. Ecce currently supports the NWChem 4.0 , Gaussian 03 , 
Gaussian 98 , and Amica codes.  

Note: The Amica code is designed to support very high levels of theory for small 
molecular systems. Unlike the Gaussian and NWChem codes, Amica will not run 
successfully if you use the default values of the setup parameters, so it is important for 
you to familiarize yourself with the official Amica documentation. The Amica 
documentation is also available through Ecce by selecting the Help button at the bottom 
of the Amica Theory Details dialog available from the Calculation Editor when you set 
up an Amica calculation. Appendix B in the Amica documentation gives further 
information specific to using Ecce to run Amica calculations.  

Because some methods or options are seldom used, and the Calculation Editor gives you 
only a subset of all possible options, you can perform a final edit of the input file before 
you launch the calculation.  

Key Concepts 

The Calculation Editor presents you with most of the application-specific options needed 
to perform a calculation with a specific computational code. As you make selections and 
set parameters, the Calculation Editor automatically enforces valid inputs by constraining 
the ranges of type-in values and menu selections based on the code, theory, and runtype 
selected. That is, after each selection or setting that you specify, the Calculation Editor 
then offers context-relevant options for subsequent selections and settings. 
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If your choices conflict with a current setting (perhaps a default), the Calculation Editor 
will disable input values to fit with your choices and display a message or warning in the 
message area at the bottom of the window. 

Starting the Calculation Editor 

In the Calculation Manager: 
1. First select a calculation.  
2. Then—  

If the calculation is NOT yet associated with a specific code: 
a. From the Tools menu, choose Calculation Editor. 

Keep holding down the mouse button to display a submenu of 
computational codes.  

b. From the submenu of codes, choose which code you want to use.
After you select a code, you can return to the Calculation Manager, and 
select another code for the calculation. Ecce will recognize you are trying 
to change the code and will prompt you to to check if you really want to 
proceed. If you select Change Code, it will change the code, bringing up 
the new Calculation Editor. This will erase any code-specific parameters 
from the prior code (Ecce will use the existing chemical system and basis 
set along with the theory/runtype if they are supported). 

If the calculation IS already associated with a specific code: 
From the Tools menu, just choose Calculation Editor. 

3.  

Menu Bar  

Each of the menus on the menu bar can be "torn off" as an independent window that 
remains visible while you work. To "tear-off" a menu, open the menu by clicking on the 
menu title and then choose the dashed line that separates the menu title from the menu 
options.  
Tip: Open any menu from the keyboard by using the Alt+underlined letter combination 
(for example, Alt+h opens the Help menu). Then select a menu option by pressing the 
letter that corresponds to the option.  
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- Calculation Menu 

The Calculation Menu enables you to: 

Save Save the current calculation parameters to the data server. Most 
calculation parameters (those in the main window and the setting for 
spin multiplicity/open shells) are saved as you specify them. The 
"Save" option is enabled only when you have modified Theory Details 
or Runtype Details. 

Save Code/ 
Theory/ 

Runtype 
Preferences 

Save the state of the currently selected theory and runtype as your 
preferred choices when entering the Calculation Editor. If Ecce detects 
a conflict between your preferences and some other parameter (such 
as your initial code selection), it will override the settings. This is 
applied only when bringing up the Calculation Editor for the first time 
on a calculation when no current theory/runtype has been set.  

Quit Close the Calculation Editor window.  
Tip: To end an Ecce session and close all tool windows at once, close 
the Gateway.  

- Help Menu  

The Help menu provides access to this online help and enables you to supply feedback 
about your experience with Ecce.  

Help on 
this tool 

Show online help information for this tool or window. 

Support Display a form for providing support requests to your onsite Ecce 
representative or adminstrator about problems, questions, or other comments. 
Note: Although your onsite Ecce administrator should be your first choice 
for problems and questions, you may address feedback or suggestions to the 
Ecce development team at ecce-support@emsl.pnl.gov.  
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Chemical System 

The Chemical System button opens the Builder tool so that you can "build" a chemical 
system or extract one from the data server. 

Once a chemical system is defined and saved to the data server, or copied to the 
Calculation Editor via a drag & drop operation, it will appear in the small viewer to right 

of the Chemical System button. The molecule can be 
rotated (with the left mouse button), translated (with the middle mouse button) or 
zoomed (with the left + middle mouse buttons). A name (in a dynamically sized name 
field) can be attached to the chemical system for labeling purposes. You can also assign 
an overall charge to the chemical system either by typing an integer value into the Charge 
text field or by clicking on the downward pointing arrow to the right of the text field. 
Changing the molecular charge may result in an automatic change in spin multiplicity as 
well as changing the theory and details defaults. 

A toggle button, Use As Irreducible Fragment In Input will display when you are 
working with the Amica code. When you turn on the option, the chemical system shown 
is taken to represent an irreducible fragment, meaning the full chemical system (based on 
the symmetry specified) is used to determine the number of atoms and electrons in the 
calculation, but only the irreducible fragment is printed in the input file. If you do not 
turn on the option, the chemical system shown is treated as the complete chemical system 
to use for the calculation regardless of any specified symmetry. Because this can be a 
difficult concept, the small chemical system viewer in the Calculation Editor updates 
based on the toggle setting to show what would currently be used by the computational 
code as the chemical system for the calculation.  

Key information about the current chemical system, such as the chemical formula and the 
point group symmetry, are also listed below the viewer. 

Spin Multiplicity 

The Spin Multiplicity button opens a new window in which you can select the number of 
open shell orbitals and the accompanying spin multiplicity. Spin 
multiplicity refers to the number of degenerate spin states that can be 
constructed from a certain number of open shell orbitals and is related to 

the total spin (S) by the expression 2S+1. 

More about... Spin Multiplicity Window 
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Theory  

The name of the currently selected level of theory appears on the front of this 
button. Clicking here causes a pull-down menu to appear with categories of 
computational methods such as SCF, DFT, SE, and MP. 

Only the computational method categories that are supported by the currently selected 
code display on the Theory menu.  

The menu is a cascading menu, which means that clicking on any of the enabled category 
names causes a secondary menu to appear with a list of all supported levels of theory 
associated with the chosen category. For example, if you click on the MP category, you'll 
see a list of the various types of Moller-Plesset perturbation theory that the code supports. 
A prefix of "U" means that the method is built on an unrestricted Hartree-Fock 
wavefunction, whereas an "R" means that the method is built on a restricted Hartree-Fock 
wavefunction. 

If you wish to change any of the Theory suboptions, you can click on the Theory Details 
button to open a Theory Details window containing some of the user-adjustable 
parameters.  

Runtype 

The name of the currently selected runtype appears on the front of this 
button. This option controls the type of work to be performed with the currently selected 
level of theory. For example, you might wish to optimize the structure of a molecule or 
compute a dipole moment. Clicking the button displays a pull-down menu with a list of 
the Ecce-supported runtypes. Only runtypes known to be available in the current code 
with the current level of theory are enabled for selection. 

These Ecce-supported runtypes may be listed on the menu: 

Energy Perform a single energy evaluation at the specified geometry.  
Gradient Evaluate the first derivative of the energy with respect to the atomic 

Cartesian coordinates.  
Geometry Minimize the molecular energy with respect to atomic coordinates. 

Analytic gradients will be used, if available.  
Polarizability Evaluate the first order electric polarizabilty (alpha) and 

hyperpolarizabilities (beta), if possible.  
Vibration Compute vibrational modes.  

GeoVib Compute optimized geometry AND vibrational modes.  
Magnetic Compute Nuclear Magnetic Resonance (NMR) coupling constants. 

(Gaussian) 
Property Supports calculation of Nuclear Magnetic Resonance (NMR) shielding 
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constants. (NWChem) 
ESP Compute Electrostatic Potential added to the NWChem Calculation 

Editor. This runtype is designed to assign partial charges to atoms by 
fitting them to the electrostatic potential obtained from the ab initio 
electronic density obtained using an RHF theory calculation. This runtype 
is supported by the new Partial Charge Toolkit in the Builder. The toolkit 
can be used to assign atom constraints and visualize constrained atoms.  

If you wish to adjust any of the options associated with a given runtype, you can click on 
the Runtype Details button to access a Runtype Details window containing some of the 
user-adjustable parameters.  

Basis Set  

The Basis Set button starts the Basis Set Tool , which enables you to make sophisticated 
choices about the details of the basis set for the calculation. The Basis Set button is 
disabled (grayed out) until a chemical system is specified. Ecce prevents you from 
selecting a basis set that is not supported by the current computational code and may also 
apply code- and theory-specific rules to basis set selection. If you change the Theory after 
selecting the basis set, Ecce will check the basis set for completeness and consistency. If 
it fails the check, Ecce will change the basis set text color to red and set the state to 
created instead of ready.  

The Use Exponents & Coefficients toggle enables you to specify 
that explicit exponents and coefficients should be used when 
generating an input file rather than basis set library names. Click 
the toggle on (the default is always off) to use expoenents and 

coefficients instead of basis set library names. The system will switch over to explicit 
exponents and coefficients when you do a save.  

Use this function if a basis set does not have an entry in the internal basis set library for 
NWChem. Several of the most recently added basis sets for v3.0 fall into this category. 
The computational code itself can be used to detect the lack of a library name by starting 
the job and letting it generate an error if basis set names are not recognized. By default 
this toggle is off so that library names will be used. Clicking the toggle on indicates to the 
Calculation Editor that the input file should be regenerated (saving is enabled). The next 
time the input file is generated it will have explicit exponents and coefficients and no 
basis set library names.  

Note: this feature does not remember the state of the toggle between Calculation Editor 
invocations. If you close the Calculation Editor and bring it up again, it will indicate that 
it isn't using exponents and coefficients even though that is what is in the input file. If 
you need to edit the same file, click the toggle on again, to be sure your settings are 
maintained in the input file. 
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Tip: Click on the quick access button (next to the Basis Set button) to bring up a quick 
selection menu of basis sets without opening the Basis Set Tool. 

Code Settings  

The code Settings area of the window summarizes the detailed theory and runtype 
parameters. Details buttons provide access to separate windows for changing specific 
input parameters. 

 

- Theory Details  

If you wish to change any of the Theory suboptions, click on the Theory Details button 
to open a Theory Details window containing some of the user-adjustable parameters. 
These include items such as the convergence threshold or the way in which the integral 
storage is handled. Most applications support a very large number of adjustable 
parameters, but only some of these are directly supported in the Calculation Editor 
interface. For special parameters you may have to edit the input file manually using the 
Final Edit button. 

Note: changing the theory in the Calculation Editor will automatically close any Theory 
Details or Runtype Details windows if they are open. Theory details parameters are reset 
to defaults whenever you change either the theory or runtype.  

- Runtype Details 

If you wish to adjust any of the options associated with a given runtype, you can click on 
the Runtype Details button to access a Runtype Details window containing some of the 
user-adjustable parameters. 

Note: changing the runtype in the Calculation Editor will automatically close any Theory 
Details or Runtype Details windows if they are open. 

Final Edit and Launch Buttons  

These are your final options for editing and launching a calculation. Using either of the 
following buttons will automatically save all current calculation parameters to the data 
server.  
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- Final Edit 

In general Ecce supports the most commonly used computational chemistry codes, but 
does not offer an input interface for every computational option. Many options are 
infrequently used, and stuffing them all into the interface would create an enormous 
amount of visual clutter. When you want to perform calculations that the Ecce interface 
doesn't support, the Final Edit button enables you to retrieve the input file in a text editor. 
It is possible to have more than one simultaneous Final Edit session, which is useful for 
comparing changes in detail dialog field settings in input files. If you have multiple 
sessions running, only the session where the final "save" is done will be used.  

Tip: The default editor for the final edit is vi, but you may be able to make it the text 
editor of your choice by setting the $EDITOR environment variable at the UNIX 
command line.  

- Launch 

Once you complete the specification of the chemical system and all essential run 
parameters (e.g., the basis set and type of calculation to be performed), the Launch button 
becomes enabled. This button opens the Ecce Job Launcher window. From this window 
you can select a machine to run your calculation and set launch parameters—the details 
needed for submitting the calculation to the computer for processing. 

How to... Set Launch Parameters in the Job Launcher

Window Footer 

At the bottom of the window is a footer that displays status information as well as a drop 
site for receiving calculation inputs that have been "dragged" from another tool: 

• the project path and name of the current calculation  
• a colored icon that indicates the current state of the calculation  
• a message area for tool instructions and system messages  
• "Save Work" Icon -  

If you see a star-shaped icon, this indicates that you have made calculation 
choices that have not yet been saved to the data server. When you are ready to 
save your choices, just click on the star icon. This is the same as selecting Save 
from the Calculation menu.  

• Padlock Icon -  
If you see a padlock icon, this indicates that the current calculation calculation 
parameters cannot be changed—for example when the calculation is already 
launched and under way.  

•  
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Drop Site - The "in-tray" square at the right side of the footer is a 
drop site destination for "drag & drop" operations. For example, if 
you launch the Calculation Editor and wish to edit the parameters of 
a newly created calculation, you can simply drag the calculation 

from the Calculation Manager and drop it on this site. This drop site also accepts 
chemical systems from the Builder. 

More about...  Items in the Ecce Window Footer  
How to...  Drag & Drop with the Mouse  
   Display a Legend of Calculation State Icons
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Overview - Basis Set Tool 

The Basis Set Tool enables you to select predefined Gaussian Basis Sets or create new 
ones for use in ab initio electronic structure calculations within Ecce. This tool also 
allows you to access general information on the basis sets stored in the EMSL Gaussian 
Basis Set Library and to seek advice on which basis sets might be most appropriate 
for a given type of calculation. 

How to... Select Basis Sets for a Calculation

Because the Basis Set Tool has many functions, for many situations it may be easiest to 
select a basis set directly from the Calculation Editor by clicking the arrow button on the 
Basis Set button (in the Calculation Editor). A short pop-up menu then displays the 
names of some frequently used basis sets that you can augment with your own favorites. 

Key Concepts: The Basis Set Tool operates in either of two modes. Generally the tool 
enables you to select basis sets for a fixed chemical system: the chemical system is 
specified by the calculation selected in the Calculation Manager or in the Calculation 
Editor. A separate Browse Mode enables you to select basis sets for an arbitrary system 
instead. 

• Calculations - If you are selecting a basis set for a calculation, then the basis set 
selection must be saved as part of a calculation. After you save a basis set 
selection, Ecce creates a default name based on the orbital basis set and any 
auxiliary functions. The basis set name will appear throughout the Ecce interface 
(for example, in the Calculation Manager) as a label associated with the 
corresponding calculation.  

• Browse Mode - If you are selecting a basis set for a chemical system in Browse 
Mode, the basis set selection cannot be saved as part of a calculation. However 
you can save it as a user defined combination for re-use later or as an ASCII file 
for use outside Ecce.  

Starting the Basis Set Tool 

 

Ways to start the Basis Set Tool: 

• In the Ecce Gateway - Click on the Basis Set Tool icon (above).  
• In the Calculation Manager - Choose Basis Set Tool from the Tools menu.  
• In the Calculation Editor - Click on the Basis Set button.  
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If the Basis Set Tool is already running, these actions bring the window to the front. To 
start a separate instance of the tool in a separate window, shift-click on the icon in the 
Gateway. If no calculation or chemical system is specified, the Basis Set Tool starts in 
Browse Mode. 

The following items briefly describe elements of the Basis Set Tool window. 

The Current Basis Set Library 

The name of the current basis set library appears in the title bar of the Basis Set Tool 
window. The default library is the last one used in the previous session. Most people will 
want to use the standard EMSL Gaussian Basis Set Library. The basis set library has been 
updated to reflect the latest basis sets from the EMSL Gaussian Basis Set Web Order 
Form. For a list of the latest changes, see the update history of the basis set library. 

Menu Bar 

Each of the menus on the menu bar can be "torn off" as an independent window that 
remains visible while you work. To "tear-off" a menu, open the menu by clicking on the 
menu title and then choose the dashed line that separates the menu title from the menu 
options.  
Tip: Open any menu from the keyboard by using the Alt+underlined letter combination 
(for example, Alt+h opens the Help menu). Then select a menu option by pressing the 
letter that corresponds to the option.  

- Molecular Basis Menu 

This menu enables you to perform operations on the entire collection of basis sets you 
have selected for use on the chemical system being studied. 

Save Save the basis sets you have selected to the Ecce database so that they 
can be used in the current calculation. If you attempt to quit the Basis 
Set Tool without first saving your selections, you will be warned and 
given a chance to save your work.  
Tip: As a shortcut way to save your basis set selections, click on the 

"Save Work" icon in the window footer .  
Save to File... Save the basis sets to an ASCII file. This option is useful if you want 

to generate basis sets for use outside of Ecce. You can put the Basis 
Set Tool into the Browse Mode (from the Browse Options menu), 
enter a chemical system, and select a format corresponding to the 
application you want to run.  

View Exponents 
& Coefficients... 

Open a window containing the Gaussian exponents and contraction 
coefficients in the proper format for the currently chosen 
application.  

Quit Close the Basis Set Tool.  
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Tip: To end an Ecce session and close all tool windows at once, close 
the Gateway.  

- Edit Menu 

The Edit Menu enables you to clear (remove) items in the Molecular Basis table of 
selected basis sets. 

Clear All Clear all items in the table. 
Clear Selection Clear the currently selected (highlighted) item in the table. 

- Atomic Bases Menu 

The Atomic Bases menu enables you to view information about the database library. 

Database Revision Log... Show the revision history of the basis set database. 
Save As...   

- Browse Options Menu 

The Basis Set Tool can operate in two modes. By default, when you start this tool from 
the Calculation Manager or Calculation Editor, the chemical system is fixed. You cannot 
switch to a different chemical system from within the Basis Set Tool. However, you can 
toggle the tool into the "Browse Mode," where you have the option of typing in any 
chemical formula you wish and selecting any code format. 

Browse 
Mode 

Toggle the Basis Set Tool into or out of the Browse Mode. In Browse 
Mode you can type in an arbitrary chemical system in the Chemical 
Formula field and select any one of the supported code formats. After 
selecting the basis sets, you can use the Save to File option in the Molecular 
Basis menu. When Browse Mode is enabled, the Import Structure option is 
also enabled. 

 
Import 

Structure... 
Open a file dialog window for importing a chemical system from a file. 
This option appears only when the Browse Mode is enabled. It enables you 
to import a variety of file formats, such as Alchemy (TRIPOS), MVM, 
PDB (Protein Data Bank), and XYZ. You must specify the format of the 
file to be imported. Other formats may become available.  
Note: At present only the chemical system (C2H4, for example) is 
imported from the file. Molecular coordinates are ignored, so it is not 
possible to select basis functions for individual atoms using the "By 
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Atom" tab option in the Molecular Basis portion of the Basis Set Tool. 

Note: NWChem and Gaussian 98 imports will generally recognize basis 
set names. The name recognition capability is more robust for NWChem 
than Gaussian 98, but it should be possible to import substantially more 
input files than previously was the case. Gaussian 98 only calculations 
where the basis set name is specified in the route card are supported. Ecce 
will not be able to identify the basis set if you try to import Gaussian 98 
files with a combination of basis set names and explicit coefficient lists or 
where the basis set names are used in the basis set field. For NWChem, 
only orbital basis sets will be imported. Fitting basis sets, such as XC and 
CD, and ECP functions will be ignored (ECP functions are also ignored 
for Gaussian imports). The orbital basis sets are sufficient to display 
molecular orbitals. 

How to... Import a Structure from a File 

- Advanced Menu 

The Basis Set Tool offers an "Advanced Mode" in support of the Amica code. This mode 
enables the inclusion of multiple orbital basis sets. The purpose of the Combine Multiple 
Basis Sets feature and the Edit Basis Set option (Contraction Editor) is to allow you to 
create your own custom basis sets by combining different contractions from heterogenous 
sources. The Contraction Editor also allows you to append tight and/or diffuse functions 
to fine-tune the endpoints of the electron distributions. These custom basis sets are 
required to obtain the higher accuracy required of the Amica code. 

Combine Multiple 
Basis Sets 

This option is off by default. Once you turn on the option, it is then 
applied to ALL codes until you turn it off.  

- Help Menu 

The Help menu provides access to this online help and enables you to supply feedback 
about your experience with Ecce.  

Help on 
this tool 

Show online help information for this tool or window. 

Support Display a form for providing support requests to your onsite Ecce 
representative or adminstrator about problems, questions, or other comments. 
Note: Although your onsite Ecce administrator should be your first choice 
for problems and questions, you may address feedback or suggestions to the 
Ecce development team at ecce-support@emsl.pnl.gov.  
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Basis Set List  

The EMSL Gaussian Basis Set database contains well over 100 basis set families, and 
more are constantly being added. To make it easier to find a particular type of basis set, 
this part of the Basis Set Tool window enables you to view selected subsets of the library. 
Select basis sets in this list by double-clicking on them (or by selecting them in this list 
and using the "Add to Table" button). Your selections are then applied to the chemical 
system (or element) selected in the Molecular Basis table in the bottom portion of the 
window. 

Picture... Basis Set List (Orbital Tab)

The tabs across the top of this area define broad categories of basis sets and/or effective 
core potentials (ECP): 

• Orbital - The Orbital tab displays a scrolling list of orbital basis sets with a set 
of vertical tabs on the left to further divide the basis sets according to their type. 
For example, the default vertical tab is "Pople Shared," which indicates that the 
list will contain all known basis sets designed to use shared (s,p) Gaussian 
exponents. Orbital sets are likely to be the ones you need most frequently.  

• ECP - The ECP tab displays a list of known effective core potentials that you 
can then match up with any orbital basis set. Most of the time you can choose an 
orbital ECP basis set and simultaneously get the accompanying ECP. However, in 
some cases you may want to use another orbital basis set, and this tab enables you 
to make that selection. If the ECP tab appears to be disabled (grayed out), the 
currently selected code does not support ECPs.  

• DFT Fit - The DFT Fitting tab displays two scrolling lists of DFT fitting basis 
sets : one contains charge fitting basis sets, and the other contains exchange 
correlation fitting functions. If the DFT Fit tab appears to be disabled (grayed out), 
the currently selected code does not support DFT fitting basis sets. Although the 
charge and exchange-correlation fitting sets are usually chosen in pairs, it is 
possible to choose only one of these, or to choose two fitting sets from different 
basis set families.  
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Basis Set Details 

The Details button opens a separate window with detailed reference and graphic 
information about the basis set that is currently highlighted in the basis set list. 

Picture... Basis Set Details (Example)
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Periodic Table  

This Periodic Table portion of the Basis Set Tool 
enables you to narrow the list of orbital basis sets by 
clicking on elements of interest. For example, if you 
select H, Sc, and Br, the basis set list shows only basis 
sets that simultaneously support all three elements. If 
the Basis Set Tool is in Browse mode, you can type in a 
chemical formula in the Chemical Formula field and 
specify basis sets for that chemical system. 

As with all instances of the Periodic Table that appear in Ecce, you can change the 
appearance of the table by pressing the right mouse button in the table area (but not on 
top of an element). By pressing the right mouse button on top of an element you can 
access element-specific information stored in the Ecce database. 

More about... Periodic Table 

Molecular Basis Area 

The Molecular Basis area in the bottom half of the Basis Set Tool displays information 
about the basis sets you have selected using the basis set list and Add to Table button.  

Molecular Basis Tabs 

These tabs in the Molecular Basis area display the currently selected basis sets in a table 
and enable you to specify how they are applied to the current chemical system. 

Picture... Detail of Tabs 
How to... Select Basis Sets for a Calculation

• Simple - This is the default tab and is used when the same basis set family is to be 
applied on all atoms in the current chemical system. The table shows you what 
basis sets are selected and characterizes each basis set according to several 
categories: orbital, polarization, diffuse, etc.  

• By Element - This tab shows a table of all unique elements in the current 
chemical system and the corresponding basis functions associated with each. You 
can construct composite basis sets with one basis set on a subset of the elements 
and another basis set on the others.  

• By Atom - [Not Implemented] This tab shows a complete listing of the atoms and 
Cartesian coordinates for the current molecule. You can then select basis 
functions on an atom-by-atom basis. Because the atomic coordinates are required, 
this option is NOT available in Browse mode.  
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Tip: You can customize the table of selected basis sets by dragging the table column 
separators with the mouse to widen, narrow, or hide columns in the table. 

Add to Table Button 

This button enables enables you to add basis sets to the Molecular Basis 
Area. To add basis sets, highlight the sets in the Basis Set List, then click the 
button to add them to the Molecular Basis Area.  

Basis Set Options Panel 

This options panel displays current settings for several options associated with the 
currently selected basis functions:  

Code: Shows the code format currently in effect. In Browse 
Mode only, this is a pull-down menu that enables you to choose a 
different code format.  
Polarization Components: Enables you to select between 
Spherical and Cartesian forms of the polarization functions.  
Optimize General Contractions: Marking this option performs 

a transformation of certain kinds of general contractions to allow them to run more 
efficiently with some programs.  

Functions and Primitives (display only): With general 
contractions the "effective" number of Gaussian primitives may 
differ from one application to another. That's why the number of 
functions listed under "Primitives" and "Eff. Primitives" may 

differ. 

Window Footer 

At the bottom of the window is a footer that displays status information as well as a drop 
site for receiving calculation inputs that have been "dragged" from another tool: 

• the project path and name of the current calculation  
• a colored icon that indicates the current state of the calculation  
• a scrolling message area for system prompts and messages  
• "Save Work" Icon -  

If you see a star-shaped icon, this indicates that you have made a basis set or code 
selection for a calculation but have not yet saved your work. When you are ready 
to save your choices, just click on the star icon.  

• Padlock Icon -  
If you see a padlock icon above and to the right of the message area, this indicates 
that the current calculation is locked in the database (probably because it has 
already been submitted) and that you will not be able to modify the basis set 
selections.  
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•  

 
Drop Site - The "in-tray" square at the right side of the footer is a 
drop site destination for "drag & drop" operations. For example, if 
you launch the Basis Set Tool and wish to use it to select basis 
functions for a calculation in the Calculation Manager, you can use 

the middle mouse button to "drag" the calculation from the Calculation Manager 
and "drop" it on the drop site in the Basis Set Tool. The Basis Set Tool then 
presents the chemical system and any prior basis set selections for that 
calculation. 

More about...  Items in the Ecce Window Footer
How to...  Drag & Drop with the Mouse  
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Overview - Machine Browser 

The Machine Browser is a tool for viewing status and reference information about 
computers that are registered as Ecce machines. You can use this information to match 
computing resources with the job resource requirements of new calculations. A primary 
use of the Machine Browser is to view or specify a computer's machine configuration--
the personal default setup information that you establish for running calculations on a 
specific machine. 

How to...  Register Machines 
   Specify a Machine Configuration

A machines list toggle button of Ecce-registered machines enables you to select one 
computer at a time for browsing information. You can select between seeing all Ecce-
registered machines, or just your Ecce configured machines. 

A status area displays information about your choice of machine status, process status, or 
disk status. The current resource status of a machine is acquired by direct queries to the 
selected computer. 

An optional reference area displays information about the selected computer's registration 
data and queue attributes. Reference information is static data from Ecce's machine 
registration. 

Key concepts: The Machine Browser displays status and reference information for one 
selected computer. Reference information is available for any Ecce-registered machine, 
but status information is available only if you have specified a machine configuration for 
the selected computer. The status and reference information is for display only and 
cannot be modified in the Machine Browser window. However, you can specify or 
modify your personal machine configuration for a computer by choosing the Configure 
Machine Access option in the Machine menu. 

Starting the Machine Browser 

 

Click on the Machine Browser icon in the Ecce Gateway (above). If the Machine 
Browser is already running, this will bring its window to the front. To start a separate 
instance of the Machine Browser in a separate window, shift-click on the icon. 

The following items briefly describe elements of the Machine Browser window. 
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Menu Bar 

Each of the menus on the menu bar can be "torn off" as an independent window that 
remains visible while you work. To "tear-off" a menu, open the menu by clicking on the 
menu title and then choose the dashed line that separates the menu title from the menu 
options.  
Tip: Open any menu from the keyboard by using the Alt+underlined letter combination 
(for example, Alt+h opens the Help menu). Then select a menu option by pressing the 
letter that corresponds to the option.  

- Machine Menu 

The Machine menu includes options for viewing machine reference information as well 
as for specifying the machine configuration of a selected computer. 

Register 
Machines...

Open a separate window to register a new machine to run Ecce jobs. 

Configure 
Machine Access...

Open a separate window for modifying the machine configuration 
(default launch parameters) of the machine selected in the machines 
list. 

Open Shell Open a UNIX window.  
Show Reference 

Information
Show/hide the lower portion of the window, which displays the 
registration data and queue attributes of the selected machine. 

Quit Close the Machine Browser window. Any changes made to the 
appearance of the window will be saved, and the same data will be 
displayed when you next open the Machine Browser.  
Tip: To end an Ecce session and close all tool windows at once, close 
the Gateway.  

- Help Menu 

The Help menu provides access to this online help and enables you to supply feedback 
about your experience with Ecce.  

Help on 
this tool 

Show online help information for this tool or window. 

Support Display a form for providing support requests to your onsite Ecce 
representative or adminstrator about problems, questions, or other comments. 
Note: Although your onsite Ecce administrator should be your first choice 
for problems and questions, you may address feedback or suggestions to the 
Ecce development team at ecce-support@emsl.pnl.gov.  
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Machines List 

The machines toggle menu at the upper left side of the Machine Browser window 
contains the names of all Ecce-registered computers and enables you to toggle between 
displaying all registered machines or only configured machines. The list displays 
reference machine names (aliases) rather than full machine names. From this list you can 
select a single computer for listing status and reference information, or for specifying a 
machine configuration (default calculation launch parameters). 

Queue Pull-Down Menu 

 

When more than one queue is available on the selected machine, the Queue pull-down 
menu below the machines list enables you to choose a queue. Status information in the 
adjacent status area is then limited to that queue only. If the Queue menu is disabled 
(grayed out), that means the selected machine does not have multiple queues. 

Status Area 

This area displays a resource status message about the currently selected machine 
whenever you click on one of the status buttons pictured below. If the selected machine 
has multiple queues, then the status information applies to the selected queue. The three 
status buttons supply different kinds of current status information:  

 
This button displays the current date and time, the length of time the 
selected machine has been up, the number of users, and the average 
number of jobs in the run queue over the last 1, 5, and 15 minutes--the 
same information as the UNIX "uptime" command. 

 This button displays information about active processes on the selected 
machine.  
For single-processor machines  

the browser lists processes having the highest processor usage--
the same information as the UNIX "top" command.  

For multiple-processor machines  
this information includes the process ID (PID), terminal 
identifier (TTY), cumulative execution time (TIME), %CPU, 
and the command name (COMD)--the same information as the 
UNIX "ps" process status command.  

 This button displays the total, used, and available numbers of disk 
blocks (1 block = 1024 bytes) for all file systems in use on the selected 
machine--similar to the UNIX "df -k" command.  

If a machine configuration (with password, logon, etc.) is NOT already specified for the 
selected machine, then you cannot query the status of that machine: the status buttons 



Ecce Version 3.2.2 Users Manual 

 77

will be disabled (grayed out). If you have an account on the selected machine, you may 
be able to specify machine configuration information by using the Configure Machine 
option on the Machine Browser menu.  

Tip: To clear text from the status area, place the mouse cursor in the status area, hold 
down the right mouse button, and choose "Clear" from the resulting pop-up menu.  

Reference Area 

The Reference Information area of the window displays general information and a queue 
attributes table for the selected machine. This display is optional: the Show Reference 
Information option in the Machine Browser menu opens or closes this part of the window. 
The reference information includes  

• vendor, operating system, and model information  
• processor, memory, nodes, and queue manager  
• a list of scratch directories  
• a list of computational chemistry codes registered on the machine  
• a table showing attributes associated with machine queue(s).  

Queue Attributes Table and View Menu 

The queue attributes table displays static, descriptive information about the queue(s) 
available on the selected machine. All table columns (except queue name) are selectable 
from the View pull-down menu. The table displays a data column for each attribute that 
you mark on the menu. The table columns are ordered as they appear on the View menu.  

 

Tip: To quickly add or subtract table columns, "tear off" the 
menu at the dashed line and use the menu as an independent 
window.   
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Message Area 

The scrolling message area at the bottom of the window displays status messages and 
other information about current operations. Look there for suggestions as well as 
messages about ongoing operations. Most Ecce tool windows contain a message area.  
Tip: To clear text from the message area, place the mouse cursor in the message area, 
hold down the right mouse button, and choose "Clear" from the resulting pop-up menu. 
Tip: To bring the Gateway to the front when it is hidden by other windows, right-click on 
the message area in the footer and choose "Show Gateway" from the resulting pop-up 
menu.  
Tip: The background of the message area will blink momentarily when a warning or error 
is reported. Warnings will blink in pale yellow while errors will blink in red.  
How to... Enable/Disable Audible Notifications of Warnings and Error Messages 
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Overview - Job Launcher 

The Job Launcher is a tool for "launching a job"—submitting a calculation to a computer 
for processing. In the Job Launcher you will specify the machine details needed to launch 
the job. These details or launch parameters include  

• the UNIX or Linux ccomputer where the calculation will be submitted for 
processing--the run machine  

• configuration information (such as queue, processors, nodes, login, and password) 
for that computer  

• directories on that computer to hold the calculation results.  

A job is a single calculation for which launch parameters have been defined. In the Job 
Launcher, you can either launch the job immediately or save the job and launch it later. 
The Job Launcher window contains a machines list for selecting a computer and a setup 
area for specifying the launch parameters. 

The Job Launcher can also display jobs that have already been submitted or completed, 
so launch parameters may be viewed for a previously run calculation. Imported 
calculations are not displayable in the Job Launcher since they have no launch 
information. 

Key Concepts: Calculations can be launched and run only on UNIX or Linux computers 
that have been registered as Ecce machines. For any Ecce machine that you wish to use, 
you can define a personal machine configuration (default launch parameters for that 
computer). For any calculation that you wish to launch on that configured machine, you 
can either use those default launch parameters or override them by specifying different 
launch parameters in the Job Launcher window. Updated machine configurations are 
shared between the Job Launcher and the Calculation Manager immediately.  

How to... Configure an Ecce Machine with Default Launch Parameters

Starting the Job Launcher 

Ways to request the Job Launcher: 

• In the Calculation Manager - Select a calculation for launching (the calculation 
must be in the "ready" state). Then from the Tools menu, choose Job Launcher.  

• In the Calculation Editor - Click on the Launch button.  

Launch button in the 
Calculation Editor 
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Another way to place a calculation in the Job Launcher is to drag a calculation from the 
Calculation Manager. If the Job Launcher window already contains a calculation and you 
request it again (or drag & drop) for a different calculation, the Job Launcher will ask if 
you want to save the current launch parameters before proceeding with the new job. 

To start a separate instance of the Job Launcher for a new job in a separate window, shift-
click on either the Job Launcher menu option (in the Calculation Manager) or the Launch 
button (in the Calculation Editor). 

The following items briefly describe elements of the Job Launcher window. 

Menu Bar 

Each of the menus on the menu bar can be "torn off" as an independent window that 
remains visible while you work. To "tear-off" a menu, open the menu by clicking on the 
menu title and then choose the dashed line that separates the menu title from the menu 
options.  
Tip: Open any menu from the keyboard by using the Alt+underlined letter combination 
(for example, Alt+h opens the Help menu). Then select a menu option by pressing the 
letter that corresponds to the option.  

- Job Menu 

The Job Menu includes the main options for saving and staging your work in the Job 
Launcher. 

Save Job Save all launch parameters as part of the current calculation. The 
calculation can be launched later by placing it in the Job Launcher and 
using the Launch button. (If the job launch parameters are different from 
those in the default machine configuration, then the job parameters will 
override the default machine configuration parameters for that 
computer. )  
Tip: To save a job without using the menu, just click on the "save 
work" icon in the window footer.  

Register 
Machines 

Open a separate window to register a new machine to run Ecce jobs. 

Configure 
Machine 
Access... 

Open a separate window for specifying or modifying your personal 
machine configuration (default launch parameters) for the machine 
selected in the machines list. This machine configuration is a time-saving 
record of default preferences that is independent of any calculation. 
Whenever you select a computer from the list of User Configured 
Machines, those defaults automatically appear in the Job Launcher's setup 
area. You can always override this default configuration for individual 
calculations by changing the job launch parameters and using Save Job. 

Save Machine Save the settings you have selected for your job launch parameters.  
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Preference 
Stage Job 

Launch 
Starts a remote xterm window in the calculation run directory. This 
allows you to modify any necessary files, including the job submission 
script by adding or changing directives that may be required on a certain 
machine but not currently supported by Ecce. This is similar to the Final 
Edit feature for the calculation editor, except that any file can be modified 
and any changes will not be stored within the Ecce data management 
system.  

Finish Staged 
Launch 

Submits the staged job and starts the monitoring process. 

Quit Close the Job Launcher window.  
Tip: To end an Ecce session and close all tool windows at once, close the 
Gateway. If you have unsaved work that is in progress and critical to the 
definition of a calculation, Ecce will ask whether you want to save your 
work before quitting. The Job Launcher will not exit when you quit Ecce 
from the Gateway while a job is currently being launched. It will 
immediately exit when it is safe to do so after the job launch is done and 
monitoring has been started.  

- Help Menu 

The Help menu provides access to this online help and enables you to supply feedback 
about your experience with Ecce.  

Help on 
this tool 

Show online help information for this tool or window. 

Support Display a form for providing support requests to your onsite Ecce 
representative or adminstrator about problems, questions, or other comments. 
Note: Although your onsite Ecce administrator should be your first choice 
for problems and questions, you may address feedback or suggestions to the 
Ecce development team at ecce-support@emsl.pnl.gov.  
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Machines List 

The machines list on the left side of the Job Launcher window contains the names of 
computers that you might select for running a calculation job. The machines list may 
contain either a list of all Ecce registered computers or a list of computers for which you 
have already defined default launch parameters (User Configured Machines). These two 
lists are selectable from the Machines toggle button above the machines list.  

All Machines List all Ecce registered machines. Although all machines are listed, you 
can launch only from a machine that supports the code required for the 
calculation. If you choose a machine that does NOT support the required 
code, the Launch button in the Job Launcher appears disabled (grayed out)

Configured 
Machines 

List User Configured Machines that can support the code associated with 
the selected calculation. If a calculation is placed in the launcher and the 
machine associated with that calculation --the default machine-- does 
NOT have the code available to run the calculation, then a message will 
inform you. You can then select from the User Configured Machines list a 
computer that can support the code specified for the calculation.  
Tip: To check the default machine of a calculation, use the Calculation 
Manager. From the Calculation Manager's View menu, choose 
Calculation Label and mark the Machine option. The default machine 
then appears in the calculation label. To get information about the status 
of each machine, use the Machine Browser.  

When you click on a computer name in the machines list, any information available for 
that computer appears in the launch parameters setup area on the right side of the Job 
Launcher window. Additional informaiton may be necessary to complete the launch 
parameters. 

Launch Parameters Setup Area 

When the Job Launcher opens, this setup area contains all available launch parameters for 
the current calculation. This information is either default machine information or job 
information that has already been saved. 

Note: If a launch parameter is disabled (grayed out), it means that the computer specified 
by the "Machine Name" does not require that particular parameter. 

• Machine Name - This field displays the name of the default machine associated 
with the current calculation OR the name of the machine selected in the machine 
list. You can also directly type in the name of an Ecce registered machine rather 
than selecting it from the list. Machines now have an associated “reference” name 
selected by the site administrator or user performing the machine registration. 
This “reference” name is the unique key for identifying the machine and the full 
machine name previously used to uniquely identify the machine is now an 
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attribute that does not need to be unique. Thus, a machine can be registered more 
than once by using different “reference” names for each instance. For instance, a 
queued machine can be registered to run both batch and interactive jobs by 
registering the machine separately with each configuration. This feature also 
allows commonly known aliases for a machine to be used when login node names 
are not well known. This feature has had a broad impact on all Ecce data 
pertaining to machine names being saved including the v3.0 changes to preference 
file formats. Applications like Job Launcher and Machine Browser that display 
lists of machines now display these reference names rather than the full machine 
names.  

Note: The Machine Name field accepts only Ecce registered machines and only 
machines that support the code required by the calculation in the Job Launcher 
window. If a machine name that you enter is NOT registered in Ecce or if the 
machine you select does NOT support the code required for a calculation, a 
message will inform you.  

•  
• Allocation Account - If the selected machine requires an allocation account for 

scheduling and tracking Ecce jobs, enter the allocation account name in this field.  

• Queue Name - If more than one queue is available on the selected machine, this 
pull-down menu enables you to select a queue. Select an appropriate queue: the 
default queue is just the first queue on the list and may not be appropriate.  

Note: For NQE/NQS machines that are configured to select the queue based on 
the requested number of nodes and specified time limit, the Job Launcher will not 
show all queues. Instead it will display the maximum number of nodes and the 
maximum time limit that any queue supports. 

•  
• Remote Shell - When more than one remote communications shell is available, 

use this menu to select a remote shell. The possible shells are rsh, ssh, ssh/ftp, and 
telnet, depending upon which are supported by the selected machine. The primary 
use of this field is to override the default remote shell for a single launch without 
changing the remote shell of the default configuration.  

Shell Comments 
ssh Preferred over other shells because it offers better security 
ssh/ftp Useful when the regular remote copy command is not working but less 

secure than ssh without ftp 
telnet Recommended only when ssh is not available. Preferred over rsh because 

it does do password authentication instead of relying solely on .rhosts files. 
When telnet is specified as the remote shell in the Machine Configuration 
dialog, ftp is automatically used for file transfer. The use of telnet requires 
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potential changes to your .login environment files for those machines 
launching Ecce jobs via telnet. See the release notes (available through the 
Ecce FAQ) for more information about using telnet as a remote 
communications shell. 

rsh Relies on .rhosts files for authentication 

•  
• Wall Time Limit (on machines that use a job queuing system) - Specify 

days/hours/minutes to set a job time limit. The job will be terminated once this 
"wall clock" interval expires. After the job begins executing, it has that much time 
to finish, regardless of how many nodes or how much CPU time it is using. A 
Max(imum) wall time limit may be specified for some machines. 

• Memory Limit (on some machines that use NQE/NQS job queuing) - Specify the 
amount of memory that the job is allowed to allocate. Beyond this memory limit 
the job must use disk storage, which has slower performance. The tradeoff is that 
setting higher memory limits may restrict the queues available for the job. 

• Priority Reduction - Leave this field blank to receive normal priority (the top 
priority possible). To reduce the priority of the calculation job, enter a number in 
the range specified [displayed in brackets]. Higher numbers designate a lower job 
priority. 

• Total Processors - For machines with multiple processors, specifiy the number of 
processors the job can access.  

• Nodes - Enter the desired number of nodes for this job. The range of available 
nodes is displayed [in brackets] after the Nodes entry field. The maximum 
number of nodes is displayed initially as a default value.  

   Remote Machine Information 

   

This information allows Ecce to get remote access to the Ecce registered machines on 
which you have accounts. Enter your account information for the machine on which 
the calculation will be run--whether it is really "remote" or not. If you have already 
configured default launch parameters for the run machine, then the remote machine 
information that you specified will appear in these fields. You can modify this 
information here for specific calculations—or in the Configure Machine window to 
change the defaults.  

• Login Name and Password - Enter your login name and password for logging in 
to the machine where you wish to submit the job. The primary use of these fields 
is to override the default login name and password for a single launch without 
changing the default configuration. 
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• Calculation Directory - This directory on the run machine stores the job setup 
information and output files. Ecce will create subdirectories to differentiate 
calculations that use the same calculation directory. After successful completion 
of a calculation, the output files are copied from this calculation directory on the 
run machine to a parallel calculation directory on the launch machine.  

More about... temporary files in the calculation and scratch directories 

•  
• Scratch Directory (Optional but recommended) - Enter the name of a scratch 

directory on the run machine--where potentially large temporary files will be 
created during processing. The scratch directory path is used as supplied: Ecce 
does NOT create subdirectories to differentiate calculations that use the same 
scratch directory.  

 If you specify a scratch directory, be sure that the directory exists and that you 
have permissions to use it. If you specify an unusable scratch directory, Ecce 
will inform you only during the launch process and will NOT launch the 
calculation.  
 If you do not specify a scratch directory, the computational code will use a 
default scratch directory– typically the directory that you specify as the 
calculation directory. If no scratch directory is explicitly set in Job Launcher, 
compute servers that support $TEMPDIR can use this environment variable for 
automatically setting the scratch directory for a job. This works for Gaussian 98, 
Amica, and some versions of NWChem 4.x. 

Note: On parallel machines, the scratch directory must be visible to all compute 
nodes. Use of node-local disks for some NWChem temporary files is handled 
separately. 

Launch Button 

The Launch button appears disabled (grayed out) until the launch parameters for a 
calculation have been specified completely. When you click on the Launch button, the 
Job Launcher 

• checks the validity of the launch parameters  
• saves the parameters as a part of the calculation  
• and submits the calculation job for processing.  

If the launch is successful, the state of the calculation becomes "submitted." If there is a 
problem with the launch parameters or with the launch process, the Job Launcher 
displays a message in the message area and stops the launch from proceeding further. 

Note: Job exit status is now accurately determined by eccejobmaster from the 
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eccejobstore return value. The number of automatic job monitoring restarts is 
conditionalized based on the time between restarts. Five monitoring restarts in less than 
60 seconds is recognized as a fatal condition where monitoring aborts. Rapid successive 
restarts indicate that the job is hitting the same problem each time, and that continued 
restart attempts will likely fail as well. 

Window Footer 

At the bottom of the window is a footer that may display the following status information: 

• the name of the current calculation (with project pathname)  
• a colored icon that indicates the current processing state of the calculation  
• a message area for system prompts and messages  
• "Save Work" Icon -  

If you see a star-shaped icon, this indicates that the current launch parameters 
have been changed but not yet saved. When you are ready to save the job, just 
click on the star icon.  

•  

 
Drop Site - The "in-tray" square at the right side of the footer is a 
drop site destination for calculations dragged from the Calculation 
Manager. 

More about...  Items in the Ecce Window Footer  
   Legend of Calculation Run States in the Calculation Manager 
How to...  Drag & Drop with the Mouse  
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Overview - Calculation Viewer 

The Calculation Viewer displays tabular and graphic summaries of the inputs and results 
associated with a single Ecce calculation. To enhance your interpretation of results, the 
properties of a chemical system can be viewed (as appropriate) in tables, graphs, and 
rendered 3D images. For some calculated dynamic or convergent-solution properties such 
as geometry, you can display step-by-step animations of the chemical system through the 
iterations of the calculation. Tables, graphic plots, and other detailed information appear 
in a summary list area. Rendered images of the chemical system with some property data 
appear in a scene viewer area. 

Key Concepts: The Calculation Viewer provides convenient access to current 
information for a single calculation at any stage of setup or completion. Its many features 
for viewing and visualizing chemical system properties make it the primary Ecce tool for 
reviewing and interpreting calculation results. You can monitor a running calculation in 
real time. As new calculation data is generated, the data display in the Calculation Viewer 
is updated automatically.  

The Calculation Viewer supports visualization of several vector and tensor quantities. In 
addition to dipole moments and normal modes, energy gradients are also displayed as 
atom-centered vectors, when available. Tensor quantities, such as the quadrupole moment, 
polarizability, or NMR shielding tensors, are displayed as a triad of orthonormal bipolar 
vectors oriented along the principle components of the tensor and scaled by the 
corresponding tensor eigenvalue. 

Charges are indicated by blue and red coloring, with a zero charge indicated by white. As 
the charge goes from the most positive charge to zero, the color changes from fully 
saturated blue to a less saturated blue until the atom is white. While going to a negative 
charge, white slowly becomes a more saturated red color until the most negative charge is 
indicated by a fully saturated red.  

 

Starting the Calculation Viewer 
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Click on the Calculation Viewer icon in the Ecce Gateway. If the Calculation Viewer is 
already running, this will bring its window to the front. To start a separate instance of the 
Calculation Viewer in a separate window, shift-click on the icon.  

In the Calculation Manager First select a calculation, then choose Calculation Viewer 
from the Tools menu. 

The selected calculation is then displayed in the Calculation Viewer. Once the Viewer is 
open, you can view data for a different calculation by dragging the calculation from the 
Calculation Manager and dropping it on the drop site of the Viewer window. To start a 
separate instance of the Calculation Viewer and view a different calculation in a separate 
window, select the calculation in any of the tools above and then shift-click on the 
Calculation Viewer option in the corresponding Tools menu. 

Tip: If you start the Calculation Viewer directly from the 
Ecce Gateway without first selecting a calculation, you 
will be able to open and view data files not stored in the 
Ecce Data Server. Currently, the only type of files 
supported are Gaussian Cube Formatted data files 
containing grid-type data. Cube files can be any type of 
data distributed on an ORTHOGONAL[em] grid (the 
cube file format supports non-orthogonal grids but these 
cannot be displayed within Ecce). Typical cube file data 
are molecular orbitals or electrostatic potentials. Cube 
files can be produced using either the Gaussian 98 suite 
of programs or NWChem.  

The following items briefly describe elements of the Calculation Viewer window. 

Summary List 

The left side of the Calculation Viewer is a scrollable summary list of the calculation 
attributes and chemical system properties. Input attributes include the computational 
code, theory/runtype, chemical system atomic coordinates, the basis set, launch 
information (machine, queue, etc.), and non-default setup parameters. Output attributes 
and calculated properties are an open-ended data set that depends on the runtype and the 
current state of the calculation. Results can include (but are not limited to) scalar 
energies, moments, energy vectors, energy gradient magnitude, Mulliken charges, normal 
modes, molecular orbitals (MOs), and partial charges. Run statistics are a standard time-
use output.  
Picture... Summary List  
 
Tip:Instead of scrolling to show wide data tables, you can increase the width of 
the summary list. Hold down the left mouse button and drag the area divider 
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handle right or left. The handle appears near the lower right corner of the 
summary list.  

 
A caption line for each list item includes control buttons, the item caption, and (in some 
cases) corresponding data. The currently selected list item is highlighted in black. 
Detailed information for any list item can be displayed by clicking on the list controls:  

• and - The arrowhead buttons either show or hide a summary data panel that 
expands below the caption line to display the data. The data panel may be a table 
or graphic plot and may include data display options for the scene viewer. A 
disabled (grayed out) arrowhead indicates that all available information is 
already displayed on the caption line.  

Tip: To hide all displayed data panels at once, open the Options menu and choose 
Collapse Property Data. 

• - A scene viewer button marks the chemical system item and each visualizable 
property. When the Calculation Viewer first opens, the button is depressed for the 
chemical system, which is displayed in the scene viewer. To enable the display of 
another property in the scene viewer, click on the scene button associated with 
that property. The scene viewer button remains depressed and the corresponding 
property can be displayed in the scene viewer until a different scene button is 
depressed. Actual display of property data in the scene viewer typically requires 
using additional controls in the property's data panel.  

Tip: For convenient reference, you can move the data panel for any item out of the 
summary list and into an independent window. Right-click on the Float icon to the 
right of the item caption. Click the Dock icon to restore the item to the summary list. 

- Data Tables and Plots 

Calculation inputs and results typically appear as tables in a data panel below the item 
caption. When the Calculation Viewer first opens, it displays the Chemical System table 
of atomic coordinates. Many properties such as Molecular Orbitals (MOs), Total Energy, 
and Geometry Trace may also be viewable as graphic plots. For those properties, 
clicking on the down arrow with the right mouse button opens a pop-up menu with 
an option to switch off the table and show a plot instead. 

Picture... Plot and Table Examples

Note: The atomic coordinates shown in the Chemical System data panel for a completed 
calculation may be different than the original input values. To take advantage of 
symmetries and reduce the complexity of the calculation, computational codes may 
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transform the chemical system coordinates to standard orientation. After this occurs, Ecce 
displays the transformed coordinates rather than the original values. 

For some properties marked by a scene viewer button , you may be able to select cells 
or rows in the property table and see corresponding data in the scene viewer.  

The pop-up menu opened by right-clicking on a data panel contains options that apply to 
the table or plot displayed. The current display (table or plot) can be printed. A table can 
be exported to a spreadsheet format. A plot may have scaling options. Menu options can 
include the following items: 

• Graph  
• Print  
• Export  

How to... View/Print/Export Property Data 

Chemical System Scene Viewer 

The right side of the Calculation Viewer is a scene viewer that displays 3D rendered 
images of the calculation's chemical system and some of its properties. Properties in the 
summary list can be displayed in the scene viewer by clicking on the associated scene 
viewer button  and interacting with the corresponding data panel in the summary list. 
Picture... Scene Viewer  

- Scene Viewer Controls 

Button Purpose 

 
Select- Switch to the Select mode cursor (arrow) for selecting and highlighting 
components of the chemical system.  
Tip: Keyboard Shortcuts  
Esc 
key 

Toggle quickly between the Select and Manipulate modes. 

Alt 
key 

In Select mode, switch the cursor to the Manipulate cursor as long as 
the Alt key is depressed.   

 
Manipulate - Switch to the Manipulate mode cursor (hand) for rotating the 
chemical system in arbitrary directions around a center point (  left mouse 
button).  
Note: It's a fine point, but these hand-cursor operations really manipulate only 
your viewpoint, NOT the items in the scene viewer. Their space coordinates 
remain constant as indicated in the Chemical System data panel. 

Tip: In Manipulate mode only--depress the middle mouse button and drag to 
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move (translate) the system in the (x,y) plane of the scene viewer.  

 
The cursor switches to the Translate cursor (hand with object). 

 
Tip: In Manipulate mode only--depress the  left + middle mouse buttons 
together (or Ctrl + ) and drag to dolly/zoom in the scene viewer.  

 
The cursor switches to the Dolly cursor (pointing hand).

  
  Tip: Do not try to select atoms to use with the following Length - Angle - 

Torsion measures while a calculation property is animating. Press Stop, select 
the atoms you are interested in, and then start the animation.  

 
Length - After clicking on this button, select two atoms or a bond, or select and 
then click the button. The distance (in angstroms) between atom centers is 
displayed along a dashed line between the atoms. 

 
Angle - After clicking on this button, select three atoms (one at a time) to define 
an angle. The measurement is displayed along a dashed line between the bonds. 

 
Torsion - After clicking on this button, select four atoms (one at a time) to define 
a dihedral angle. The first three atoms define one plane, while the second three 
atoms define another plane. The measurement is displayed along with the planes 
that define the angle. 

 
Cancel - Removes all displayed measures from the viewer. 

 
Clipboard - Displays any image in the viewer in a separate clipboard window. 
You can place several different viewer images into the clipboard for comparison. 
Although you cannot modify an image in the clipboard, you can still manipulate 
it. The maximum number of images you can place on the clipboard is determined 
by the memory of your machine. You should probably not have more than 10 
images on the clipboard at any one time. New measures are not copied to the 
clipboard.  
Tip: If the orbital transparency is not displaying correctly, rotate the clipboard 
object. 
Picture... Clipboard Example 

 
Home - Reset the chemical system in the scene viewer to a "Home" orientation.  
Tip: Home key Reset to "Home" orientation like the Home button.   

 
Set Home - Establish the current chemical system orientation as the "Home" 
setting. 

 
View All - Unzoom and center the chemical system to bring all components 
within the viewer area. 

 
Seek - Switch to Seek cursor (cross hairs) for selecting an object as the view 
center point of the chemical system. After selection, the cursor returns to its 
previous mode. 

 
Perspective View - This button indicates that the scene viewer is showing a 
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perspective view: "closer" objects appear relatively larger. Clicking on this button 
toggles the scene viewer (and the button's icon) to the ortho view. 

 
Ortho View - This button indicates that the scene viewer is showing an 
orthogonal view: objects appear a constant size, regardless of their front-to-back 
positioning. Clicking on this button toggles the scene viewer (and the button's 
icon) to the perspective view. 

The following "thumbwheel" and slider controls are operated by dragging with the left 
mouse button. 

Control Purpose 
Dolly/Zoom 
Thumbwheel 

In perspective view, this thumbwheel is labeled "Dolly" and moves the 
point of view into (or out of) the depth of the scene viewer. In ortho 
view, this thumbwheel is labeled "Zoom" and merely enlarges or 
shrinks the size of the scene viewer image.  
Tip: In Manipulate mode only--depress the  left + middle mouse 
buttons together (or Ctrl + ) and drag to dolly/zoom in the scene 
viewer.  

 
The cursor switches to the Dolly cursor (pointing hand). 

  
X  This thumbwheel rotates the chemical system around the horizontal 

(X) axis at the current center of rotation. 
Y This thumbwheel rotates the chemical system around the vertical (Y) 

axis at the current center of rotation. 
Z This thumbwheel rotates the chemical system around the orthogonal 

(Z) axis at the current center of rotation.  
Tip: To display X-Y-Z axes and make the thumbwheel rotations more 
clear, open the View menu and mark Axes.  

Iso/Amplitude 
Slider 

For visualizing molecular orbitals and electron densities, the slider at 
the top of the scene viewer is labeled "Iso" and sets a value to be 
depicted as isosurfaces. For normal mode animations, the slider is 
labeled "Amplitude" and sets the amplitude of motion for the 
animation. 

- Visualizable Properties 

The following are key examples of calculation attributes and properties that can be 
visualized in the scene viewer. 

Grids  
If you start the Calculation Viewer from the Gateway, the Calculation Viewer will 
display the Grids property viewer, along with an Import button. This enables you to 
import a file with gridded data (a *.cube file) and view it in the Scene Viewer. Cube files 
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are usually molecular orbitals or electrostatic potentials, but could be any property in a 
cube file with the appropriate 3D format. 

Chemical System 
When the Calculation Viewer first opens, the chemical system of the selected calculation 
appears in the scene viewer (if a chemical system has been specified for the calculation). 
The chemical system shows the last step for optimizations or the starting geometry if 
there are no steps or the transformed geometry if available. The general appearance of the 
chemical system and its atoms, bonds, and labels can be specified by using the Display 
menu and Chemical System menu on the window menu bar.  

Measures can be added to the chemical system and viewed in all other properties. 
Measures can be viewed once a calculation has finished running. The measures buttons 
are located on the left edge of the scene viewer and permit you to display:  

• Length (the distance between two atoms)  
• Angles (between three atoms)  
• Torsions (between four atoms)  
• Cancel measures.  

More about... Measures and their icons  
(General Tables of Properties) 

For many properties, you can select cells or rows in the property table and see 
corresponding data as text labels in the scene viewer. For example, for Mulliken charges 
you can select charge values in the table and see them display on the corresponding 
atoms of the chemical system. 

Geometry Trace 
Geometry trace results are visualized in an animation of the chemical system. Features 
include  

• buttons for playing and stopping the animation  
• forward and backward buttons for stepping through the geometry steps of the 

animation  
• capability to drag a set of coordinates to start a new calculation  
• the length of a time delay between the frame steps of the animated sequence  
• measures can be added and will update during animation  
• coordinates dislplayed in the Geometry Table will update during the animation. 

Normal Modes 
Vibrational normal modes are visualized in an animation of the chemical system. 
Animation controls include  

• buttons for playing and stopping the animation loop(s)  
• a choice of Vector or animation displays  
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• capability to drag a set of coordinates to start a new calculation  
• graph of Raman or IR spectra  
• the number of animations (frame steps) in a complete sequence  
• the length of a time delay between the frame steps of the animated sequence  
• a slider (in the scene viewer) for setting the amplitude of motion  
• symmetry labels  
• coordinates dislplayed in the Geometry Table will update during the animation. 

Mulliken Charges 
Mulliken charges are visualized in a color spectrum on the model of the chemical system. 
Features include  

• display of the accumulating charges on the atom corresponding to the color 
spectrum.  

• ability to select charge values from the property table and see them display on the 
corresponding atoms of the chemical system.  

• mulliken shell charges are available for viewing if the system was computed by 
NWChem.  

Molecular Orbitals (MOs) 
Molecular orbitals are visualized for any molecular orbital selected one at a time from the 
data table. Spin densities are evaluated by subtracting the total electron density due to the 
alpha electrons from the total electron density due to the beta electrons. Note that even 
for unrestricted theories, this will only result in a nonzero spin density for open shell 
systems.  

MO display controls include  

• an option to show coefficients (as a second table in the data panel) and to set a 
threshold cutoff value for ignoring coefficients that are below the threshold  

• A pull-down menu for selecting either table or energy level diagram graph display 
mode.  

• a pull-down menu for selecting a display mode:  

MO isosurfaces for one selected molecular orbital 
Density isosurfaces for total electron density (all occupied orbitals) 

• Spin Density is available if you have run an unrestricted theory (for example, 
UHF, UDFT, UMP2) .  

• a Compute button for computing the display images for the corresponding 
molecular orbital(s).  

• a slider (in the scene viewer) for setting the value that is depicted as isosurfaces.  
• symmetry labels.  
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Note: The Surface menu on the Calculation Viewer's menu bar is active only for MOs 
and contains several options for controlling the detail, extent, and appearance of 
isosurfaces. 

Note: The threshold cutoff value applies to all calculations.

Molecular orbital energies are displayed in either a table or graphical form. The 
molecular orbital graph displays orbitals based on their relative energies. The orbitals are 
also color coded to show whether they are occupied, unoccupied, or, in the case of 
restricted-open shell systems, partially occupied. The orbitals can also be further 
separated into alpha and beta orbitals and into their different symmetry group 
representations. 

Partial Charges 
Partial charges are visualized in a color spectrum on the model of the chemical system. 
You can also view constraints and/or restraints added to the fitting algorithm. To copy the 
partial charges back to the original structure so that they can be used in further 
calculations, click the Assign Charges button. Partial charge data is extracted by Ecce 
from the <Calculation>.q file generated by NWChem.  

Display controls include  

• display of the partial charges on the atom corresponding to the color specturm  
• ability to select charge values from the property table and see them display on the 

corresponding atoms of the chemical system.  
• ability to view the following after an ESP calculation  

o ESP: Charge fit to the Electrostatic Potential  
o CESP: Constrained charge fit to the Electrostatic Potential  
o RESP: Restrained charge fit to the Electrostatic Potential  
o CRESP: Constrained Restrained charge fit to the Electrostatic Potential.  

Shielding Tensor 
Shielding Tensors are visualized as a triad of orthonormal bipolar vectors oriented along 
the principle components of the tensor and scaled by the corresponding tensor 
eigenvalue. Features include  

• a pull-down menu that contains the options "By Atom"  
• a list of all elements in your system.  

This makes it easy to view the tensors for all H atoms. You can select atoms in the table 
and you can also select them in the scene viewer. 

Moments 
Visual representations of the dipole and quadrapole moments are available. These 
provide a quick visual reference of how the moments are oriented relative to the 
molecular geometries.  
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The molecular polarizability is displayed using the principle components of the 
polarizability tensor. These are scaled by the relative magnitudes of the polarizability 
tensor eigenvalues. The display provides a quick method of identifying the highly 
polarizable orientations of the molecule. 
 

Menu Bar 

Each of the menus on the menu bar can be "torn off" as an independent window that 
remains visible while you work. To "tear-off" a menu, open the menu by clicking on the 
menu title and then choose the dashed line that separates the menu title from the menu 
options.  
Tip: Open any menu from the keyboard by using the Alt+underlined letter combination 
(for example, Alt+h opens the Help menu). Then select a menu option by pressing the 
letter that corresponds to the option.  

- Calculation Menu 

View 
Input 
File... 

Open a window to display input file for the calculation. The input file of the 
calculation can be viewed but not edited. 

View 
Output 

File... 

Open a window to display the output file for calculation. The output file of 
the calculation can be viewed but not edited. 

Export... Open a window for exporting the chemical system to a chemical system 
format (such as PDB, XYZ, MVM, and others) or to export the image in the 
scene viewer to a graphic file format (POV-Ray, Postscript, RGB, GIF, TIFF, 
or JPEG). 

Image 
Capture 

Capture an image or a sequence of images in the Scene Viewer. A series of 
captured images can be used for movies or animated GIF files for the web. 
You can capture a sequence of steps as in a geometry trace, or you can 
capture in real-time, as when you spin a scene. Image capture supports the 
following formats: POV-Ray, Postscript, RGB, GIF, TIFF and JPEG. 

Tip: To use the equipment in the EMSL Graphics and Visualization Lab, 
you should save to RGB files. Set the size option to video.  

Print ... Open a window for printing the displayed image to a selected printer. 
Quit Close the Calculation Viewer window.  

Tip: To end an Ecce session and close all tool windows at once, close the 
Gateway.  

- Edit Menu 
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The Edit menu enables you to: 
Select All Select all atoms in the work area. 

Select Molecule Select the entire molecule or fragment associated with a single 
selected atom.  

Reverse Selection Reverse the selection you just made - select everything except what 
you had currently selected. 

Unselect All Unselect all atoms in the work area. 
Select Within 

Radius...
Select all atoms or residues within a defined radius of currently 
selected atom(s). 

- Display Menu 

The Display menu controls how the atoms and bonds of a chemical system are depicted 
in the work area. It also provides a 3D positioning tool for placing items in the work area.

Style (All) > Choose from a submenu to select a general display style for depicting 
atoms and bonds in the work area. (See also Details on this Display 
menu.)  
Ball & Stick Ball & Wireframe 
Stick (bonds) Wireframe (bonds) 
CPK (space filling) Picture... Atom/Bond Styles 

Style (Selected) > Choose from a submenu to select a display style for depicting all 
selected atoms and bonds in the work area.  
Ball & Stick Ball & Wireframe
Stick (bonds) Wireframe (bonds)
CPK (space filling) Invisible  

Render Quality > Choose from a submenu to select a quality level for rendering the 
atoms and bonds in the work area:  
High  Medium 
Low Very Low

As the rendering quality decreases, the 
rendering/display speed increases. 

Customize... Open a window of chemical system display 
attributes for modifying the appearance details of 
atoms and bonds. If the molecule is being rendered 
as a wireframe, you can control the line width. If 
you're using stick rendering, you can control the 
appearance of the stick endcaps, their quality, and 
their radius. Other options control the Ball & Stick 
quality.  
Picture... Customize Details: Chemical System 

Display Options   
Render as > Choose from a submenu to select how to render the surfaces of atoms 

in the work area:  
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Normal solid surface 
Mesh polygon lattice
Dots dot lattice  

Move as > Choose from an identical submenu to select which image rendering 
style is used as you move and manipulate the chemical system.  
Note: This may be useful for speeding up the manipulation of a 
chemical system on slow hardware. Depending on your computing 
platform and details settings (below), the manipulation of the 
chemical system may be faster and smoother with Mesh or Dots.  

Stereo Mark this option to see a stereo 3D image of the chemical system on 
workstations equipped with CrystalEyes® stereo viewing glasses.  
Note: The monitor must first be enabled for stereo viewing by using 
a hardware-specific display command .  

Depth Cueing Mark this option to simulate depth perspective: closer objects appear 
brighter than more distant objects. This is especially useful for 
viewing larger molecules. 

Transparency When this option is marked, objects in the work area become partially 
transparent so that you can see how objects overlap. 

- View Menu 

The View menu enables you to show or hide hydrogen atoms and various labels in the 
scene viewer. It also provides an option to view the geometry in a tabular format. 

Hydrogen 
Atoms 

Show/hide hydrogen atoms in the work area (if any). 

Atom Labels Show/hide labels for all atoms in the work area. 
Bond Labels Show/hide labels for all bonds in the work area. 

Axes Show/hide a set of Cartesian axes that can be used as visual indicators 
within the work area. 

Geometry 
Table... 

Display a table of geometry information and other details about the atoms 
of the current chemical system. The table displays atomic symbols, 
Cartesian coordinates, and Protein Data Bank (PDB) information if 
available. Selecting and highlighting row items in the table will select and 
highlight the corresponding atoms in the work area. The table dynamically 
updates as the system is animated.  
Picture... Geometry Table 
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- Options Menu 

The Options menu enables you to generate bonds for imported chemical systems, control 
details of the "clean" operation, set background and label colors, and use the special 
display features of the scene viewer. 

Edit 
Background 

Color... 

Open a color chooser window for modifying the background color of the 
scene viewer.  
Picture... Background Color Chooser Window 

Edit Atom 
Label Color... 

Open a similar color chooser window for modifying the color of the 
labels (atomic symbols, bond lengths, etc.) in the work area. 

Auto 
Normalize 

Display 

When this option is marked, the Builder recenters the chemical system as 
you work, continually orienting and scaling the chemical system to fit in 
the work area as you add or subtract structures. When turned off, no 
centering will be done except when changing calculations.  

Enable 
Spinning 

When this option is marked, you can use the Manipulate mode cursor 
(hand) to impart a spin to a chemical system around its center of mass. 
To stop the spin, click anywhere in the scene viewer. Unmark this option 
to prevent accidental spinning. 

Open All 
Property Data 

Show all detailed information in the summary list for all properties. 

Collapse 
Property Data 

Show only the list of properties in the summary list area. Any detailed 
information being displayed in the summary list is removed from view. 
All tables and graphs are closed . 

- Surface Menu 

The Surface menu provides options for controlling the appearance of chemical system 
surfaces. This menu is available only when a property with associated surfaces 
(molecular orbitals--MOs) is selected in the summary list area of the window. The Hide, 
Slice, and Details options become available only after surfaces have been computed for 
display by using the Compute button on the MOs data panel. 

Style options for rendered MO surfaces (see also Details on this menu)
Solid Mesh Contour 
Picture... Surface Styles 
Color options for rendered MO surfaces 
Red/Green Red/Blue Blue/Yellow Light/Dark 
Other Options 

Hide Mark/unmark this option to hide/show the current surfaces in the chemical 
system viewing area. 

Define Grid... Open a window for defining the 3D coordinate grid for which surface 
values will be computed for display in the scene viewer. The window 
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enables you to define both the grid resolution (number of values along 
each dimension) and extent (limits of each dimension). Note that the 
amount of time required to compute a grid property increases rapidly with 
grid resolution.  
Picture... 3D Grid Definition Window 

Slice... Open a window for controlling grid slicer planes (XY, XZ, YZ) and 
colors. You can use these to highlight features of the chemical system.  
Picture... Grid Slicer Example 

Details... Open a window for setting the (solid) surface transparency from 0 (opaque 
surface) to 1 (invisible surface at 100% transparency).  
Picture... Surface Details Window 

- Run Mgmt Menu 

The Run Management menu provides options for monitoring the progress of a running 
calculation and cleaning up files created by the calculation. 

tail -f  on Output 
File... 

Open an xterm window that shows the contents of the output file for 
the current calculation so that you can monitor its progress in real time 
as it runs. The output file scrolls in the window as the calculation runs.

shell in 
Calculation Run 

Directory 

Open an xterm window into the scratch directory (on the machine that 
is running the calculation) where Ecce stores temporary files during 
processing. With the proper knowledge of UNIX and the 
computational code, you can monitor what is happening. 

Terminate 
Calculation 

Stops the current calculation job. 

- Help Menu 

The Help menu provides access to this online help and enables you to supply feedback 
about your experience with Ecce.  

Help on 
this tool 

Show online help information for this tool or window. 

Support Display a form for providing support requests to your onsite Ecce 
representative or adminstrator about problems, questions, or other comments. 
Note: Although your onsite Ecce administrator should be your first choice 
for problems and questions, you may address feedback or suggestions to the 
Ecce development team at ecce-support@emsl.pnl.gov.  
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Window Footer 

At the bottom of the window is a footer that displays status information as well as a drop 
site for receiving calculation inputs that have been "dragged" from another tool: 

• the project path and name of the current calculation  
• a colored icon that indicates the current state of the calculation  
• a message area for system prompts and messages  
• Padlock Icon -  

If you see a padlock icon, this indicates that the current calculation is either 
running, completed , or imported and locked in the data server.  

•  

 
Drop Site - The "in-tray" square at the right side of the footer is a 
drop site destination for "drag & drop" operations. For example, you 
can use the middle mouse button to drag a calculation from the 
Calculation Manager and drop it on this site. The Calculation 

Viewer then displays all available information for that calculation. 
More about...  Items in the Ecce Window Footer  
How to...  Drag & Drop with the Mouse  
   Display a Legend of Calculation State Icons
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Overview - Periodic Table 

The Periodic Table tool provides quick access to a variety of element-specific 
information, including atomic mass, isotopic abundance, nuclear spins, and electronic 
configuration. You can set the appearance of the table to correspond to one of several 
color scheme conventions, such as the physical state at room temperature or the metallic 
nature of the elements. 

Key Concepts: The Periodic Table is available as a standalone tool from the Ecce 
Gateway or as an integrated tool within the Basis Set Tool and the Builder. Several 
Periodic Table color schemes are available independently in both in the standalone 
Periodic Table and in the Basis Set Tool. The Builder's Periodic Table is displayed only 
with "user colors." This user-defined color scheme can be selected and modifed within all 
instances of the Periodic Table. 

Starting the Periodic Table Tool 

 

• In the Ecce Gateway - Click on the Periodic Table icon (above) to open a 
standalone Periodic Table window.  

• In the Builder - Click on the more... button in the Periodic Table section of the 
control panel. The window title then reads "Ecce Periodic Table: Builder - 
Elements and Geometry."  

• In the Basis Set Tool - The Periodic Table is integrated in the Basis Set Tool and 
does not require starting.  

If a Periodic Table window is already open, clicking on the Gateway icon or on the 
Builder's more... button will bring the corresponding window to the front. To start a 
separate instance of the standalone Periodic Table in a separate window, shift-click on the 
Gateway icon. 

The following items briefly describe components of the standalone Periodic Table 
window. Some components, such as the menubar, are absent from the Periodic Table are 
available in the Basis Set Tool and from the Builder. 

Tip: In any instance of the Periodic Table, click the right mouse button on the Periodic 
Table elements or background to open a pop-up menu of available options.  

Menu Bar 
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Each of the menus on the menu bar can be "torn off" as an independent window that 
remains visible while you work. To "tear-off" a menu, open the menu by clicking on the 
menu title and then choose the dashed line that separates the menu title from the menu 
options.  
Tip: Open any menu from the keyboard by using the Alt+underlined letter combination 
(for example, Alt+h opens the Help menu). Then select a menu option by pressing the 
letter that corresponds to the option.  

- File Menu  

Quit Close the Periodic Table window and end this session. Any changes made to the 
appearance of the table are saved in the context in which the table was accessed. 
Thus, the next time you return to the tool from which you opened the Periodic Table 
tool, the state in which you left the table will be restored.  
Tip: To end an Ecce session and close all tool windows at once, close the Gateway. 

- View Menu  

Selecting options in this menu will highlight the periodic table in different ways. 
Element-specific information and the means to change the display colors of elements are 
also available. 

Element Coloring Schemes - The first five menu options are element coloring schemes: 
four pre-set conventional schemes and one user-defined scheme.  

Green All elements are a single shade of green. 
Physical 

States 
Elements are colored according to their physical state at room temperature: 
solid, liquid, gas, radioactive. 

Metallic 
States 

Elements are colored according to their metallic nature: conductors, 
semiconductors, insulators. 

Default 
Colors 

Elements are colored using the default Ecce color scheme.  
Picture... Default Colors 

User 
Colors 

Elements are colored according to a scheme that you have defined through the 
Atomic Data option (below). These user colors are used for color cues in the 
Builder and (optionally) in the Basis Set Tool. Until you modify them, the 
user colors are the same as the Ecce default colors. 

Element-Specific Data - The remaining menu options enable the display of element-
specific data. 

Show 
Numbers 

For each element in the periodic table, show the atomic number in addition to 
the element symbol, such as 1 H or 3 Li. 

Atomic 
Data... 

Display a window with element-specific data, such as atomic weights for the 
various isotopes, electron affinity, and ionization potentials.  
Picture... Atomic Data Window
The atomic data displayed initially corresponds to the element that is 
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currently selected in the Periodic table (its button appears depressed). 
Selecting different elements in the table automatically displays corresponding 
data in the Atomic Data window. In this window you can also set preferences 
for the display colors of individual elements and for atomic radii (covalent 
radius, van der Waal radius, bond formation tolerance).  
How to... • View Element-Specific Information  

• Customize Element Colors  
• Set Radii Preferences for Generating Bonds 

 

- Help Menu 

The Help menu provides access to this online help and enables you to supply feedback 
about your experience with Ecce.  

Help on 
this tool 

Show online help information for this tool or window. 

Support Display a form for providing support requests to your onsite Ecce 
representative or adminstrator about problems, questions, or other comments. 
Note: Although your onsite Ecce administrator should be your first choice 
for problems and questions, you may address feedback or suggestions to the 
Ecce development team at ecce-support@emsl.pnl.gov.  

Elements and Table Area 

Information about any element can be accessed from the Periodic Table simply by 
positioning the cursor over an element in the table, clicking the right mouse button, and 
selecting Atomic Data... from the resulting pop-up menu. An Atomic Data window then 
displays tabbed options for 

• viewing experimental reference data  
• viewing ionization potentials  
• setting the display color of each element for "user colors"  
• setting covalent radius, van der Waals radius, and bond formation tolerance for 

each element.  

Access to the other display options (color schemes, atomic numbers) of the View menu 
can be accessed by positioning the cursor over an open area of the table (not on an 
element), clicking the right mouse button, and selecting from the resulting pop-up menu. 

Note: Color schemes are not available for the Periodic Table accessed from the Builder, 
where only "User Colors" are displayed.  
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Overview - Ecce Gateway and Global Preferences 

The Gateway and Global Preferences window enables you to customize the behavior and 
appearance of some Ecce components as described here. Any changes you make in the 
window affect you (your account) and no one else. The options in the Preferences 
window are divided onto two functional tabs:  

Tab Preference Options 
Miscellaneous various units, date format, audible beep notifications, Gateway behaviors
Run States colors associated with various run state icons of a calculation or job 

Key Concepts: The changes you make in the Preferences window affect the behavior and 
appearance of other Ecce tools . When you open the window for the first time, all 
preference options are set at the Ecce default values. If you modify these settings, you 
must "Save" the new settings before they can take effect. 

If you open the Preferences window later (during the same Ecce session), the option 
settings will be as you last left them, regardless of whether you saved them or not. 
Therefore the displayed settings reflect your last visit to the window in the same session 
but may NOT reflect the current behavior and appearance of Ecce. 

Starting the Preferences Window 

 

Click on Preferences in the Gateway (above). If the Preferences window is already open, 
this action will bring the window to the front. To start a separate instance of the 
Preferences window, shift-click on Preferences in the Gateway (although why you'd want 
to do that is almost beyond human understanding). 

The following items briefly describe elements in the tabs of the Preferences window. 

Miscellaneous Preferences 

Units 
Energy Hartree, kcal/mol, electron Volts, kj/mol, cm-1, Mdyne A 
Distance Angstrom, Pm, Bohr 
Frequency em-1, electron Volt 
Miscellaneous Global 
Date Format Choose format for month (m) day (d) and year (y): 
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mm/dd/yyyy OR dd/mm/yyyy OR mmm dd, yyyy 
Notifications Mark these options to cause an audible beep to accompany error and 

warning messages. These messages appear in the message area of many 
tool windows.  
Beep on Errors ...whenever a message marked "error" appears in the 

message area. 
Beep on 
Warnings 

...whenever a message marked "warning" appears in 
the message area.  

Gateway 
Request 
Confirmation 
on Exit 

Mark this option to see a confirmation dialog upon exiting the Gateway. 
The dialog gives you the option to close the Gateway but leave other 
tools open. If you do not "Request Confirmation on Exit," then exiting 
the Gateway will automatically exit all Ecce tool windows (with 
prompts to save current work, when appropriate). 

Show System 
Busy Icon 

Mark this option to cause the Ecce "wave" icon in the Gateway to be 
animated whenever the system is busy (such as opening a new tool 
window). Or unmark this option to prevent the animation.  
Tip: If you want to stop the animation for just one instance, click on the 
Ecce wave while it is moving.  

Run States Color Preferences 

Use the Run States tab of the Preferences window to set the colors of the calculation run 
state icons wherever they appear in Ecce.  

Note: The icon representing an "imported" calculation is always set to the same color 
as the "completed" icon . The color of the "imported" icon is not specified separately.  
 
Item Description 
Ecce The first column of icons (labeled Ecce) shows the system default colors. 
username The second column of icons (labeled with your username) shows the optional 

color set, which you define. 
State The State buttons are for setting the corresponding username icons to the 

current color in the color selector. 
Color 
Editor 

Select from the following checkboxes to pick a color selection method. 

Name Check this option to select a color from 
the color name drop-down list. A 
sample of the selected color will 
display in the Color field when you 
select a color.  
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Picture... Run States Color Preferences 
by Name  

RGB Check this option to use slider controls 
to adjust Red-Green-Blue (RBG) color 
components independently. Decimal 
indicators on each slider indicate the 
value (0-255) of each component color. 
A sample of the selected color will 
display in the Color field as you adjust 
the colors.  

HSB Check this option to use the sliders to 
adjust the colors to the desired Hue, 
Saturation, and Brightness (HSB) 
components independently. Decimal 
indicators on each slider indicate the 
value (0-255) of each component color. 
A sample of the selected color will 
display in the Color field as you adjust 
the colors.   

To choose your own color set: 

1. Choose one of the three Color Editor checkboxes for selecting new colors.  

2. Optional: Click on a colored icon in either column to set the color selectors to that 
color.  
 
It doesn't matter which type of icon you click on: this action only affects the color 
selector setting. You might do this, for example, to place the color selector into a 
range where you can select a similar color.  

3. Select a color with the chosen Color Editor.  
 
The color panel below the color selector displays the selected color.  

4. Click on one of the State buttons to associate the selected color with that state.  
 
In the second column the corresponding icon changes to the selected color.  

5. After all desired modifications, click on the Save button to put into effect all the 
run state color choices in the second column.  

Preferences Window Controls 

 Save the current conditions of all preferences on BOTH tabs. 
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You MUST use the Save button if you want any modified settings in the 
Preferences window to take effect. 

 Reset the preferences on BOTH tabs to Ecce default values. 

 Close the Preferences window. 
When you next open the Preferences window, it will display the same settings it 
displayed when the window was closed. 

 Show this online help for using the Preferences window. 
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Overview - Support  

The Support requests web form is the mechanism for reporting problems or addressing 
questions to your onsite Ecce representative. 

EMSL users and collaborators may also email requests, comments, and suggestions 
directly to the Ecce development team at ecce-support@emsl.pnl.gov. 
 
Other users of Ecce at other sites: Please contact your onsite representative first to see 
if your need or problem can be resolved. If your site administrator has configured Ecce's 
tool support option, the Help menu of each tool window contains a Support option for 
sending email to your onsite representative. 

Starting the Support Form 

 

Ways to start the Support requests web form:  

• From the Gateway - Click on Support in the Gateway (above).  
• From other Ecce tools - From the Help menu on the tool's menu bar, choose 

Support.  
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Overview - Ecce Online Help 

The Ecce online help uses the Netscape or Mozilla web browser to display "help pages" 
about Ecce tools, processes, and conventions for interaction. The online help provides 
several layers and kinds of assistance as you use Ecce: 

• Help Contents page -- The Help Contents page is a one-page listing of hypertext 
links to the main topics of the Help system.  

• Quick Help -- For many items in an Ecce tool window, you can open a Quick 
Help window that describes the item in brief. If Quick Help supplies the 
information that you need, you can just close the Quick Help window and 
continue working. If you need more information, a hypertext link in the Quick 
Help window opens a main help page with a complete overview of the specific 
tool.  

• Main Help pages -- The main help pages contain Overview descriptions, "How-
To" procedures and tips, and (in some cases) tutorial Examples.  

• Global Help Tools -- General information tools (such as the Glossary or Index) 
are accessible from any help page.  

Key Concepts 

Here are a few things you should know about how the Ecce online help uses your web 
browser.  

• Your browser is Ecce's browser. If Netscape or Mozilla is open when you 
activate the online help, the help pages may take over the browser window.  

• About that "Back" button. The main help pages are presented in a set of frames, 
so the web browser's "Back" button may not work the way you would like it to 
work. Depending on where you have navigated in the help pages, you may need 
to click on the Back button up to three times to move back one help page. Don't 
be alarmed if some parts of the help pages "blank out" as you do this: stick with it 
and you'll generally get back to where you were. It is often faster to use the other 
navigational features of the online help.  

How to... Navigate Online Help Pages

• Suggested web browser settings. Help page viewing may be improved by 
adjusting some web browser options. Some of these adjustments are essential. For 
example, Javascript must be enabled for the main help pages to display correctly.  

How to... Set Up Netscape or Mozilla for Online Help

Starting the Ecce Online Help 

The online help can be accessed from the Ecce software in three ways.  
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Gateway 
option 

To see the Help Contents page, click on the "help" option in the Ecce 
Gateway. This is your only direct access to the Help Contents Page from 
the software. 

menu 
or 

button 

To see the Overview of a tool or window, open the tool's Help menu and 
choose Help on [that tool]. Or if the window has has no menus but only a 
Help button, then just click on the Help button instead. All Ecce tool 
windows contain a Help menu. Most task windows that are opened within 
a tool contain a Help button. 

 To see a Quick Help short description of an item, point the mouse cursor 
at the item in a tool or window and press the Help key (F1 on Silicon 
Graphics keyboards). The Quick Help will include a hypertext link to the 
Overview and may include other links to related help pages. If no Quick 
help is available for the item, Ecce usually opens the Overview help page 
directly. 

The Help Contents Page 

The Help Contents page is the home page of the Ecce online help. Starting from there, 
you can navigate anywhere within the help system and access other information resources. 
On any other page of the help system, a "Help Contents" button will bring you directly to 
this page.  

Page Area Contents and Behaviors 

 
Click on the Ecce HELP button (here OR on the Help Contents page) to 
display a pop-up window with annotated pictures of the help pages. 

Help 
Headlines & 
Topics 

The dark headlines on the Help Contents page mark the major groups of 
online help topics. The headlines and the topics below them are all links to 
main help pages where you can go to read the topic details. General and 
introductory topics are highlighted in blue. Tools help pages are 
highlighted in yellow. 

Global Help 
Tools 

The buttons in the lower left corner of the page are used for navigating to 
the general information tools of the help system and other Ecce resources 
outside the help system. 
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Global Help Tools 

The buttons in the lower left corner of every help page give you global access to the 
following Ecce information resources. Most of the buttons open independent browser 
windows when you click on them. Two of these buttons (the Ecce website, and the 
Support buttons) will take you outside the help system.  

Button Behavior 

 Go to the Ecce website on the World Wide Web. The Ecce website 
presents background and general information about the Extensible 
Computational Chemistry Environment. 

 Open a separate Index window for using the Help index. 

 Open a separate Glossary window for browsing the definitions of selected 
Ecce terms. 

 
 Go to the Help Contents page (from a main help page). 

 The following capabilities are not implemented in Ecce 3.2.2 

 Open a separate Frequently Asked Questions window for browsing 
answers to common questions [Not Implemented]. 

 Open a separate Search window for searching out help topics [Not 
Implemented]. 

 Open a separate Annotations window for attaching custom notes to help 
topics [Not Implemented]. 

 Open a separate window to Ecce's link library of online documentation 
[Not Implemented]. 

Main Help Pages 

You can get to the main help pages for an Ecce tool from the Help Contents page or 
directly from the Help menu of the tool window.  

Page Area Contents and Behaviors 

 

Icon Button. Many help pages have a button in the upper left corner of the 
page. Click on that button (at the top of this page, for example) to display a 
pop-up window with an annotated picture of the Ecce window described 
there. For each major Ecce tool, the face of the button is the icon for that 
tool. 

  

 

Topic Tabs. Many help topics are organized with three topic tabs that link 
to three kinds of help topics. Click on a topic tab to highlight the tab and 
display the corresponding information in the main text area of the help page. 
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If there is no help information for a tab, then the tab is disabled (italicized 
and grayed out). 

 The Overview page for an Ecce tool focuses on the "whats" of the tool: 
what the tool does and what are the components of the tool window. 
Hypertext links in the Overview may lead to related topics within "How To" 
pages of tasks and procedures. 

 The "How To" help pages describe how to use the Ecce tool and accomplish 
computational chemistry tasks. From a pull-down menu located on each 
"How To" page, you can select from a list of related "How To" pages, 
including a Tips page that lists shortcuts and alternative methods for Ecce 
interactions. 

 A few tutorial Examples step you through specific scenarios for using Ecce 
tools or accomplishing Ecce processes. 

  
Topic 

Headings 
The bulleted list on the left side of a main help page is the table of contents 
for the information currently displayed in the main text area of the page. 
Click on one of these links to to place the information for that topic at the 
top of the main text area. The list is composed of the headings within the 
main text area.  
Tip: The first bullet in a help page's table of contents is always the 
"Introduction". Select this list item to go to the top of the main text.  

Main Text The main text area of the page contains the detailed help information. 
Embedded in the main text you may find hypertext links to other help pages, 
including pop-up windows for optionally displayed pictures and reference 
information.  
How to... Print Online Help Pages 

Global 
Help Tools 

Every main help includes the global help tools, including the "Help 
Contents" button for navigating to the Help Contents page. 

 


